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UNIT-I: 

OVERVIEW OF COMPUTER         (L-7 HOURS) 

What is Computer, Basic Applications of Computer, Components of Computer System, Central Processing 

Unit (CPU), VDU, Keyboard and Mouse, Other input/output Devices, Computer Memory, Concepts of 

Hardware and Software: Concept of Computing, Data and Information, Applications of IECT, connecting 

keyboard, mouse, monitor and printer to CPU and checking power supply. 

 

What is a Computer? 

A computer is an electronic device that accepts data from the user, processes it, produces results, displays them 

to the users, and stores the results for future usage. 

Data is a collection of unorganized facts & figures and does not provide any further information regarding 

patterns, context, etc. Hence data means "unstructured facts and figures". 

Information is a structured data i.e. organized meaningful and processed data. To process the data and convert 

into information, a computer is used. 

 

Basic Applications of Computer: 

Home 

Computers are used at homes for several purposes like online bill payment, watching movies or shows at home, 

home tutoring, social media access, playing games, internet access, etc. They provide communication through 

electronic mail. They help to avail work from home facility for corporate employees. Computers help the 

student community to avail online educational support. 

Medical Field 

Computers are used in hospitals to maintain a database of patients‘ history, diagnosis, X-rays, live monitoring 

of patients, etc. Surgeons nowadays use robotic surgical devices to perform delicate operations, and conduct 

surgeries remotely. Virtual reality technologies are also used for training purposes. It also helps to monitor the 

fetus inside the mother‘s womb. 

Entertainment 

Computers help to watch movies online, play games online; act as a virtual entertainer in playing games, 

listening to music, etc. MIDI instruments greatly help people in the entertainment industry in recording music 

with artificial instruments. Videos can be fed from computers to full screen televisions. Photo editors are 

available with fabulous features. 

Industry 

Computers are used to perform several tasks in industries like managing inventory, designing purpose, creating 

virtual sample products, interior designing, video conferencing, etc. Online marketing has seen a great 

revolution in its ability to sell various products to inaccessible corners like interior or rural areas. Stock markets 

have seen phenomenal participation from different levels of people through the use of computers. 



 

Education 

Computers are used in education sector through online classes, online examinations, referring e-books, online 

tutoring, etc. They help in increased use of audio-visual aids in the education field. 

Government 

In government sectors, computers are used in data processing, maintaining a database of citizens and supporting 

a paperless environment. The country‘s defense organizations have greatly benefitted from computers in their 

use for missile development, satellites, rocket launches, etc. 

Banking 

In the banking sector, computers are used to store details of customers and conduct transactions, such as 

withdrawal and deposit of money through ATMs. Banks have reduced manual errors and expenses to a great 

extent through extensive use of computers. 

Business 

Nowadays, computers are totally integrated into business. The main objective of business is transaction 

processing, which involves transactions with suppliers, employees or customers. Computers can make these 

transactions easy and accurate. People can analyze investments, sales, expenses, markets and other aspects of 

business using computers. 

Training 

Many organizations use computer-based training to train their employees, to save money and improve 

performance. Video conferencing through computers allows saving of time and travelling costs by being able to 

connect people in various locations. 

Arts 

Computers are extensively used in dance, photography, arts and culture. The fluid movement of dance can be 

shown live via animation. Photos can be digitized using computers. 

Science and Engineering 

Computers with high performance are used to stimulate dynamic process in Science and Engineering. 

Supercomputers have numerous applications in area of Research and Development (R&D). Topographic 

images can be created through computers. Scientists use computers to plot and analyze data to have a better 

understanding of earthquakes. 

 

Components of Computer System 

Computer systems consist of three components as shown in below image: Central Processing Unit, Input 

devices and Output devices. Input devices provide data input to processor, which processes data and generates 

useful information that‘s displayed to the user through output devices. This is stored in computer‘s memory. 



 

Central Processing Unit 

The Central Processing Unit (CPU) is called "the brain of computer" as it controls operation of all parts of 

computer. It consists of two components: Arithmetic Logic Unit (ALU), and Control Unit. 

 

Arithmetic Logic Unit (ALU) 

Data entered into computer is sent to RAM, from where it is then sent to ALU, where rest of data processing 

takes place. All types of processing, such as comparisons, decision-making and processing of non-numeric 

information takes place here and once again data is moved to RAM. 

Control Unit 

As name indicates, this part of CPU extracts instructions, performs execution, maintains and directs operations 

of entire system. 

Functions of Control Unit 

Control unit performs following functions − 

 It controls all activities of computer 

 Supervises flow of data within CPU 

 Directs flow of data within CPU 

 Transfers data to Arithmetic and Logic Unit 

 Transfers results to memory 

 Fetches results from memory to output devices 

Memory Unit 

This is unit in which data and instructions given to computer as well as results given by computer are stored. 

Unit of memory is "Byte". 

1 Byte = 8 Bits 



 

 

List of Input Devices 

Given below is the list of the most common input devices along with brief information about each of them. 

1. Keyboard 

 A simple device comprising keys and each key denotes either an alphabet, number or number 

commands which can be given to a computer for various actions to be performed 

 It has a modified version of typewriter keys 

 The keyboard is an essential input device and computer and laptops both use keyboards to give 

commands to the computer 

2. Mouse 

 It is also known as a pointing device 

 Using mouse we can directly click on the various icons present on the system and open up various files 

and programs 

 A mouse comprises 3 buttons on the top and one trackball at the bottom which helps in selecting and 

moving the mouse around, respectively 

 In case of laptops, the touchpad is given as a replacement of the mouse which helps in the movement of 

the mouse pointer 

3. Joy Stick 

 It is a device which comprises a stick which is attached at an angle to the base so that it can be moved 

and controlled 

 Mostly used to control the movement in video games 

 Apart from a computer system, a joystick is also used in the cockpit of an aeroplane, wheelchairs, 

cranes, trucks, etc. to operate them well 

4. Light Pen 

 It is a wand-like looking device which can directly be moved over the device‘s screen 

 It is light-sensitive 

 Used in conjunction with computer‘s cathode ray tube 

5. Microphone 

 Using a microphone, sound can be stored in a device in its digital form 

 It converts sound into an electrical signal 

 To record or reproduce a sound created using a microphone, it needs to be connected with an amplifier 

6. Scanner 

 This device can scan images or text and convert it into a digital signal 

 When we place any piece of a document on a scanner, it converts it into a digital signal and displays it 

on the computer screen 

7. Barcode Reader 

 It is a kind of an optical scanner 



 It can read bar codes 

 A source of light is passed through a bar code, and its aspects and details are displayed on the screen 

All the devices mentioned above are the most commonly used input devices. Several other such types of 

equipment are used in different fields which can be counted as an input device. 

 

List of Output Device 

The commonly used output devices have been listed below with a brief summary of what their function is and 

how they can be used. 

1. Monitor 

 The device which displays all the icons, text, images, etc. over a screen is called the Monitor 

 When we ask the computer to perform an action, the result of that action is displayed on the monitor 

 Various types of monitors have also been developed over the years 

2. Printer 

 A device which makes a copy of the pictorial or textual content, usually over a paper is called a printer 

 For example, an author types the entire book on his/her computer and later gets a print out of it, which is 

in the form of paper and is later published 

 Multiple types of printers are also available in the market, which can serve different purposes 

3. Speakers 

 A device through which we can listen to a sound as an outcome of what we command a computer to do 

is called a speaker 

 Speakers are attached with a computer system and also are a hardware device which can be attached 

separately 

 With the advancement in technology, speakers are now available which are wireless and can be 

connected using BlueTooth or other applications 

4. Projector 

 An optical device which presents an image or moving images onto a projection screen is called a 

projector 

 Most commonly these projectors are used in auditoriums and movie theatres for the display of the 

videos or lighting 

 If a projector is connected to a computer, then the image/video displayed on the screen is the same as 

the one displayed on the computer screen 

5. Headphones 

 They perform the same function as a speaker, the only difference is the frequency of sound 

 Using speakers, the sound can be heard over a larger area and using headphones, the sound is only 

audible to the person using them 

 Also known as earphones or headset 

 

  



Computer Memory 

A memory is just like a human brain. It is used to store data and instructions. Computer memory is the storage 

space in the computer, where data is to be processed and instructions required for processing are stored. The 

memory is divided into large number of small parts called cells. Each location or cell has a unique address, 

which varies from zero to memory size minus one. For example, if the computer has 64k words, then this 

memory unit has 64 * 1024 = 65536 memory locations. The address of these locations varies from 0 to 65535. 

Memory is primarily of three types − 

 Cache Memory 

 Primary Memory/Main Memory 

 Secondary Memory 

Cache Memory 

Cache memory is a very high speed semiconductor memory which can speed up the CPU. It acts as a buffer 

between the CPU and the main memory. It is used to hold those parts of data and program which are most 

frequently used by the CPU. The parts of data and programs are transferred from the disk to cache memory by 

the operating system, from where the CPU can access them. 

 

Advantages 

The advantages of cache memory are as follows − 

 Cache memory is faster than main memory. 

 It consumes less access time as compared to main memory. 

 It stores the program that can be executed within a short period of time. 

 It stores data for temporary use. 

Disadvantages 

The disadvantages of cache memory are as follows − 

 Cache memory has limited capacity. 

 It is very expensive. 

Primary Memory (Main Memory) 

Primary memory holds only those data and instructions on which the computer is currently working. It has a 

limited capacity and data is lost when power is switched off. It is generally made up of semiconductor device. 

These memories are not as fast as registers. The data and instruction required to be processed resides in the 

main memory. It is divided into two subcategories RAM and ROM. 



 

Characteristics of Main Memory 

 These are semiconductor memories. 

 It is known as the main memory. 

 Usually volatile memory. 

 Data is lost in case power is switched off. 

 It is the working memory of the computer. 

 Faster than secondary memories. 

 A computer cannot run without the primary memory. 

Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is slower than the main memory. 

These are used for storing data/information permanently. CPU directly does not access these memories, instead 

they are accessed via input-output routines. The contents of secondary memories are first transferred to the 

main memory, and then the CPU can access it. For example, disk, CD-ROM, DVD, etc. 

 

Characteristics of Secondary Memory 

 These are magnetic and optical memories. 

 It is known as the backup memory. 

 It is a non-volatile memory. 

 Data is permanently stored even if power is switched off. 

 It is used for storage of data in a computer. 

 Computer may run without the secondary memory. 

 Slower than primary memories. 

 

  



Concept of Hardware and Software 

The concept of hardware and software is explained in detail below − 

Hardware 

The term hardware refers to mechanical device that makes up computer. Computer hardware consists of 

interconnected electronic devices that we can use to control computer‘s operation, input and output. Examples 

of hardware are CPU, keyboard, mouse, hard disk, etc. 

 

 

Hardware Components 

Computer hardware is a collection of several components working together. Some parts are essential and others 

are added advantages. Computer hardware is made up of CPU and peripherals as shown in image below. 

 

Software 

A set of instructions that drives computer to do stipulated tasks is called a program. Software instructions are 

programmed in a computer language, translated into machine language, and executed by computer. Software 

can be categorized into two types − 

 System software 

 Application software 



System Software 

System software operates directly on hardware devices of computer. It provides a platform to run an 

application. It provides and supports user functionality. Examples of system software include operating systems 

such as Windows, Linux, Unix, etc. 

Application Software 

An application software is designed for benefit of users to perform one or more tasks. Examples of application 

software include Microsoft Word, Excel, PowerPoint, Oracle, etc. 

 

Differences between Software and Hardware are sorted out below − 

Sr.No. Software Hardware 

1 It is a collection of programs to 

bring computer hardware system 

into operation. 

It includes physical components of computer 

system. 

2 It includes numbers, alphabets, 

alphanumeric symbols, identifiers, 

keywords, etc. 

It consists of electronic components like ICs, 

diodes, registers, crystals, boards, insulators, etc. 

3 Software products evolve by 

adding new features to existing 

programs to support hardware. 

Hardware design is based on architectural 

decisions to make it work over a range of 

environmental conditions and time. 

4 It will vary as per computer and its 

built-in functions and 

programming language. 

It is mostly constructed for all types of computer 

systems. 

5 It is designed and developed by 

experienced programmers in high-

level language. 

The hardware can understand only low-level 

language or machine language. 

6 

It is represented in any high-level 

language such as BASIC, 

COBOL, C, C++, JAVA, etc. 

The hardware works only on binary codes 1‘s and 

0‘s.  



7 The software is categorized as 

operating system, utilities, 

language processor, application 

software, etc. 

The hardware consists of input devices, output 

devices, memory, etc. 

 

Data and Information 

Usually, the terms ―data‖ and ―information‖  are used interchangeably. However, there is a subtle difference 

between the two. 

In a nutshell, data can be a number, symbol, character, word, codes, graphs, etc. On the other hand, information 

is data put into context. Information is utilised by humans in some significant way (such as to make decisions, 

forecasts etc). 

A basic example of information would be a computer. A computer uses programming scripts, formulas, or 

software applications to turn data into information. 

Let us have a detailed look at the difference between data and information in a tabular column below: 

 

Difference between Data and Information 

Data Information 

Data is unorganised and unrefined facts Information comprises processed, organised 

data presented in a meaningful context 

Data is an individual unit that contains raw materials 

which do not carry any specific meaning. 

Information is a group of data that collectively 

carries a logical meaning. 

Data doesn‘t depend on information. Information depends on data. 

Raw data alone is insufficient for decision making Information is sufficient for decision making 

An example of data is a student‘s test score The average score of a class is the information 

derived from the given data. 

 

 

Applications of IECT: 

IECT stands for Information Electronics and Communication Technology. The applications of IECT are E-

governance and Multimedia and Entertainment. E-governance is one of most efficient and successful medium 

between Government and people. Status of land applications, domicile certificate, income certificate, status of 

scholarship, status of government functionaries working in his village/block/district, Government Orders etc. 

can be easily connected through this technology. 



When more than one medium is used for Interaction/Presentation, it is called multimedia. TV, Computer 

etc. are some examples. Having audio and visual medium for the presentation. It is a combination of media 

used for creating Graphics, Animation, Text, Sound, image, full motion video, interactive features etc. 

 

              IECT stands for Information Electronics and Communication Technology. The applications of IECT 

are as follows − 

 E-governance 

 Multimedia and Entertainment 

E-governance 

Electronic governance is application of Information Electronics and Communication Technology in running an 

effective governance system for people. Communication refers to sharing of information between parties like 

common people, government, business, etc. Almost every government sector has changed to IECT like rail 

reservation system, gas subsidy disbursal, etc. 

 

 

Multimedia and Entertainment 

Multimedia refers to combination of text, audio, video, graphics, animation, etc. It is one of applications of 

IECT. Multimedia is used to improve quality of presentation by incorporating information sharing, usage of 

graphics and animation, motion capture, etc. 

                                                        

 



 

Connecting keyboard, mouse, monitor and printer to CPU and checking power supply. 

 

Connect all cables 

 

Monitor 

 

The monitor data cable will plug into the computer in only one place. Most monitors use either a DVI, VGA, 

or HDMI connector and plug into the corresponding port on the back of the computer. If your monitor only has 

a VGA plug and your computer only has a DVI connection, or visa versa, you need a video converter to 

connect your monitor. 

After connecting the data cable to the computer, connect the power plug from the monitor to the surge 

protector. 

 

Keyboard and mouse 

 

The keyboard and mouse usually connect to the computer with a PS/2 or USB connector. These connectors are 

usually on the back of the computer. 

https://www.computerhope.com/jargon/d/dvi.htm
https://www.computerhope.com/jargon/v/vga.htm
https://www.computerhope.com/jargon/h/hdmi.htm
https://www.computerhope.com/jargon/v/videoconv.htm
https://www.computerhope.com/jargon/p/powecord.htm
https://www.computerhope.com/jargon/p/ps2.htm
https://www.computerhope.com/jargon/u/usb.htm


Computer power cord 

For the computer, find the power cord and plug one end into the back of the computer (only one end fits). Plug 

the other end of the power cord into a power outlet or surge protector. 

We highly recommend both the computer and monitor be powered through a surge protector to protect it 

from power surges. If your house experiences frequent brown outs or black outs, consider using 

a UPS (uninterruptible power supply) to help protect your computer. 

 

Speakers 

If you have computer speakers, they can also be plugged into the back of the computer. The speakers connect to 

the line out or sound out port (usually green) on the back of the computer. If your speakers are powered 

speakers, the power cord should also be plugged into the surge protector. 

 

Internet 

 

Finally, if you are using a wired Internet connection, connect, the category 5 Ethernet cable to the back of the 

computer. If you are planning on using Wi-Fi to connect to the Internet, only a Wi-Fi router needs to be in 

range of the computer. 

 

Turn the computer on 

You can now turn the computer on and allow it to load up into Windows. Upon booting up the computer, you 

are asked a few questions, such as your name, location, and network settings to help finalize the set up. 

 

Connect printer  

If you also purchased a printer, or other computer peripherals, start installing the drivers for each of the devices 

after the computer is running properly. 

 

Connecting the printer to the computer 

 

https://www.computerhope.com/jargon/p/powecord.htm
https://www.computerhope.com/jargon/o/outlet.htm
https://www.computerhope.com/jargon/s/surgprot.htm
https://www.computerhope.com/jargon/s/surge.htm
https://www.computerhope.com/jargon/v/voltdrop.htm
https://www.computerhope.com/jargon/b/blackout.htm
https://www.computerhope.com/jargon/u/ups.htm
https://www.computerhope.com/jargon/s/speaker.htm
https://www.computerhope.com/jargon/l/lineout.htm
https://www.computerhope.com/jargon/c/cat5.htm
https://www.computerhope.com/jargon/w/wifi.htm
https://www.computerhope.com/jargon/r/router.htm
https://www.computerhope.com/jargon/p/printer.htm


Connect the printer to the computer either using a USB cable, parallel port cable, or SCSI cable, and then 

connect the power plug to a power outlet. Today, most home computer printers are using a USB cable similar to 

the example picture. 

If this is a network printer, connect the printer to a wireless network or the RJ-45 connection. 

A laptop computer works the same way as a desktop and can use any of the above connections if they are 

available. 

Smartphone and tablet users must have a printer that connects to devices wirelessly or over the Internet to print. 

 

Turning on a printer 

After connecting the printer to the computer, it can be turned on using the power button on the front of the 

printer. Typically the power button is on the front right corner of the printer. However, the button placement 

depends on the type of printer you have. Older laser printers may even have a power switch in one of the back 

bottom corners of the printer. 

 

Setup printer and install software 

After connecting the printer and turning it on, you'll need to install the printer's software and drivers. Every 

printer should come with the software used to install a printer in Windows or your operating system. 

1. After everything is plugged in, turn on the computer. 

2. Insert the CD that came with the printer. If the CD does not automatically start, open My 

Computer, double-click the CD drive, and then click the Setup or Install file. If you have 

downloaded the drivers, run the downloaded setup file. 

3. Follow the installation wizard, and once completed, your software is installed. 

4. Test the printer to make sure it is working. 

 

Computer with no CD, DVD, or disc drive 

If your computer does not have a disc drive or you lost the CD, you can download the software for your printer 

from the manufactures printer's driver page. Once the drivers are downloaded, you can run the file to install the 

drivers. 

 

No drivers available for my operating system 

Newer operating systems may not support all older printers. For example, Windows 10 may not support a 

printer that was made years before it was released. If drivers are not listed on a printers' driver page, your 

operating system or your versions of Windows does not support that printer. You can try installing an earlier 

version of operating system drivers, and it may work. However, for full support, consider getting a new printer. 

 

Installing a printer only using the drivers 

If you only want the printer to be installed and none of the extra software programs, you can only install the 

printer driver by following the steps below. 

https://www.computerhope.com/jargon/u/usb.htm
https://www.computerhope.com/jargon/p/paraport.htm
https://www.computerhope.com/jargon/s/scsi.htm
https://www.computerhope.com/jargon/c/cable.htm
https://www.computerhope.com/jargon/o/outlet.htm
https://www.computerhope.com/jargon/w/wifi.htm
https://www.computerhope.com/jargon/r/rj45.htm
https://www.computerhope.com/jargon/l/laptop.htm
https://www.computerhope.com/jargon/s/smartphone.htm
https://www.computerhope.com/jargon/t/tablet.htm
https://www.computerhope.com/jargon/b/button.htm
https://www.computerhope.com/jargon/p/powerswi.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/issues/ch000250.htm#test
https://www.computerhope.com/jargon/o/optidisc.htm
https://www.computerhope.com/jargon/d/download.htm
https://www.computerhope.com/drivers/printers.htm
https://www.computerhope.com/jargon/o/os.htm
https://www.computerhope.com/jargon/w/windows-10.htm


A listing of printer drivers and software is on our printer drivers page. 

If you have installed the printer doing the above steps, these steps should not be necessary unless you 

encountered errors. 

1. Open the Control Panel with the printer connected and powered on. 

2. In the Control Panel, double-click the Printers or Printers and Fax icon. 

3. In the Printers window, click the Add a printer icon. 

4. After completing the above steps, see the Windows Printer Wizard. Click Next to start the 

wizard. 

5. Next, you have the choice of installing a Local or Network printer. If the printer connects 

directly to your computer, choose Local printer attached to this computer and click Next. 

6. When prompted for the printer driver location, browse to the directory of your drivers or point 

it to the printer CD. 

 

Does a printer require drivers? 

Yes. For a printer to communicate and work with the computer and its operating system, it requires a driver to 

be installed. In some situations, you can use a generic printer driver included with the operating system, but 

these generic drivers don't always work with all printers. 

Although a driver is required, the extra software for the printer is rarely required for the printer to work. 

 

Test the printer 

After installing the printer, you can use Windows to print a self-test page to help verify the printer is working. 

Microsoft Windows users 

1. Open the Control Panel. 

2. Double-click the Devices and Printers, Printers, or Printers and Fax icon. 

3. Right-click the printer you want to test and click Properties. If you do not see your printer, 

your printer is not installed. 

4. In the Printers Properties window, click the Print Test Page button. 

5. If the printer can print a test page, your printer is installed and set up properly. However, if 

you cannot print in other programs, the program you are attempting to print from has issues. 

If the printer can print a test page, your printer is installed and working. You can configure other printer settings 

by opening the printer software or the Printers & scanners section in Windows. 

 

  

https://www.computerhope.com/drivers/printers.htm
https://www.computerhope.com/issues/control-panel.htm
https://www.computerhope.com/jargon/d/doublecl.htm
https://www.computerhope.com/issues/control-panel.htm
https://www.computerhope.com/jargon/p/pushbutt.htm


Unit-II 

UNIT-II:  MICROSOFT EXCEL                                                                                          (L-4+T-3 HOURS) 

Introduction to Spreadsheets – Use of Spreadsheet – Spreadsheet Basics – Formatting a Spreadsheet – Graphs – 

Functions of Microsoft Excel – Starting Microsoft Excel – Excel Work Environment – Changing size of a 

Work book and Excel Window – Cell and Cell Address – Standard Toolbar – Formatting toolbar – the Formula 

bar – Status bar – Components of an Excel Workbook. Working in Excel: Entering data in cell address – 
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INTRODUCTION TO SPREADSHEETS  

Microsoft Excel is a commercial spreadsheet application, written and distributed by Microsoft for Microsoft 

Windows and Mac OS X. At the time of writing this tutorial the Microsoft excel version was 2010 for 

Microsoft Windows and 2011 for Mac OS X. 

Microsoft Excel is a spreadsheet tool capable of performing calculations, analyzing data and integrating 

information from different programs. 

By default, documents saved in Excel 2010 are saved with the .xlsx extension whereas the file extension of the 

prior Excel versions are .xls. 

Step 1 − Click on the Start button. 

 

Step 2 − Click on All Programs option from the menu. 

 

Step 3 − Search for Microsoft Office from the sub menu and click it. 



 

Step 4 − Search for Microsoft Excel 2010 from the submenu and click it. 

 

This will launch the Microsoft Excel 2010 application and you will see the following excel window. 

 

The following basic window appears when you start the excel application. Let us now understand the various 

important parts of this window. 

 

File Tab 



The File tab replaces the Office button from Excel 2007. You can click it to check the Backstage view, where 

you come when you need to open or save files, create new sheets, print a sheet, and do other file-related 

operations. 

Quick Access Toolbar 

You will find this toolbar just above the File tab and its purpose is to provide a convenient resting place for the 

Excel's most frequently used commands. You can customize this toolbar based on your comfort. 

Ribbon 

 

Ribbon contains commands organized in three components − 

 Tabs − They appear across the top of the Ribbon and contain groups of related commands. Home, 

Insert, Page Layout are the examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below the group on the Ribbon. 

For example, group of commands related to fonts or group of commands related to alignment etc. 

 Commands − Commands appear within each group as mentioned above. 

Title Bar 

This lies in the middle and at the top of the window. Title bar shows the program and the sheet titles. 

Help 

The Help Icon can be used to get excel related help anytime you like. This provides nice tutorial on various 

subjects related to excel. 

 

Zoom Control 

Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you can 

slide left or right to zoom in or out. The + buttons can be clicked to increase or decrease the zoom factor. 

View Buttons 

The group of three buttons located to the left of the Zoom control, near the bottom of the screen, lets you switch 

among excel's various sheet views. 

 Normal Layout view − This displays the page in normal view. 

 Page Layout view − This displays pages exactly as they will appear when printed. This gives a full 

screen look of the document. 

 Page Break view − This shows a preview of where pages will break when printed. 

Sheet Area 

The area where you enter data. The flashing vertical bar is called the insertion point and it represents the 

location where text will appear when you type. 

Row Bar 



Rows are numbered from 1 onwards and keeps on increasing as you keep entering data. Maximum limit is 

1,048,576 rows. 

Column Bar 

Columns are numbered from A onwards and keeps on increasing as you keep entering data. After Z, it will start 

the series of AA, AB and so on. Maximum limit is 16,384 columns. 

Status Bar 

This displays the current status of the active cell in the worksheet. A cell can be in either of the fours states 

(a) Ready mode which indicates that the worksheet is ready to accept user inpu (b) Edit mode indicates that 

cell is editing mode, if it is not activated the you can activate editing mode by double-clicking on a cell (c) A 

cell enters into Enter mode when a user types data into a cell (d) Point mode triggers when a formula is being 

entered using a cell reference by mouse pointing or the arrow keys on the keyboard. 

Dialog Box Launcher 

This appears as a very small arrow in the lower-right corner of many groups on the Ribbon. Clicking this button 

opens a dialog box or task pane that provides more options about the group. 

MS Excel is a commonly used Microsoft Office application. It is a spreadsheet program which is used to 

save and analyse numerical data. 

In this article, we bring to you the important features of MS Excel, along with an overview of how to 

use the program, its benefits and other important elements. A few sample MS Excel question and answers are 

also given further below in this article for the reference of Government exam aspirants.  

 

Use of Spreadsheets: 

 

Business Data Storage 

A spreadsheet is an easy way to store all different kinds of data. These data types can include financial data, 

customer data and product data. Excel spreadsheets can support more than a million rows and more than 

16,000 columns, so you‘ll have plenty of space to store a huge amount. That‘s what makes them ideal for 

database creation. 

 

Accounting and Calculation Uses 

Businesses across the world use spreadsheets to keep track of their business accounts. You can enter formulas 

that will do all of your business calculations as you go without the expense of using accounting software. 

Spreadsheets will do all the calculations for you, which saves you having to do those calculations manually.  

 

Budgeting and Spending Help 

Keep track of your business spending on a spreadsheet. You can create custom budget spreadsheets to 

manage your income and your expenditures so you don‘t end up with any surprises when it‘s time to file your 

tax return. 



Assisting with Data Exports 

Spreadsheets can be used to contain data that has been exported from other systems. Sometimes online data 

management systems don‘t present data in a format that is easy to read, or it is difficult to access the data 

offline. 

 

Data Sifting and Cleanup 

Use your spreadsheets to identify inaccuracies and duplicates in your data. With a spreadsheet, it‘s easy to 

get rid of unwanted or low quality data. This is especially necessary in relation to customer data, which you 

are required to keep up to date and accurate. 

 

Generating Reports and Charts 

Use spreadsheets to report trends or make business forecasts. These reports can be made available to 

everyone at the company; they can take the time to analyze the data for themselves. It‘s easy to make 

comparisons between sets of data. You can pivot tables to showcase particular aspects of your data as well, 

which is necessary when you‘ve got huge amounts of data to sort through. 

Data in a spreadsheet can be used to create charts that can then be used for reporting. You can create graphs 

and pie charts that condense the data in a format that‘s easy to read at a glance. It‘s a fantastic feature that can 

be great for business presentations that require you to showcase lots of data in a short time. 

 

Business Administrative Tasks 

Use spreadsheets for the creation of receipts and invoices. You can also use it to do business related forecasts 

and plan ahead for the future. 

These are some of the common purposes spreadsheets are used for, but there are additional ways you can 

utilize a spreadsheet to achieve your business goals. Configure them to your needs, and tap into all the ways 

you can use this simple yet effective tool. 

 

Formatting a Spreadsheet 

Formatting text or numbers can make them appear more visible especially when you have a large worksheet. 

Changing default formats includes things like changing the font color, style, size, text alignment in a cell, or 

apply formatting effects. This article shows you how you can apply different formats and also undo them. 

 



If you want text or numbers in a cell to appear bold, italic, or have a single or double underline, select the cell 

and on the Home tab, pick the format you want: 

 

Change font style, size, color, or apply effects 

Click Home and: 

 For a different font style, click the arrow next to the default font Calibri and pick the style you want. 

 To increase or decrease the font size, click the arrow next to the default size 11 and pick another text size. 

 

 To change the font color, click Font Color and pick a color. 

 To add a background color, click Fill Color next to Font Color. 

 

 To apply strikethrough, superscript, or subscript formatting, click the Dialog Box Launcher, and select an 

option under Effects. 



 

 

Change the text alignment 

You can position the text within a cell so that it is centered, aligned left or right. If it‘s a long line of text, you 

can apply Wrap Text so that all the text is visible. 

Select the text that you want to align, and on the Home tab, pick the alignment option you want. 

 

 

Excel Graphs 

A chart is a tool you can use in Excel to communicate data graphically. Charts allow your audience to see the 

meaning behind the numbers, and they make showing comparisons and trends much easier. In this tutorial, you 

will learn how to insert charts and modify them so they communicate information effectively. Each of Excel's 

12 chart types has different features that make them better suited for specific tasks. Pairing a chart with its 

correct data style will make the information easier to understand, enhancing the communication within your 

small business. 

 

In Microsoft Excel, charts are used to make a graphical representation of any set of data. A chart is a visual 

representation of data, in which the data is represented by symbols such as bars in a bar chart or lines in a line 

chart. 

Excel provides you different types of charts that suit your purpose. Based on the type of data, you can create a 

chart. You can also change the chart type later. 

Excel offers the following major chart types − 

 Column Chart 

 Line Chart 

 Pie Chart 

 Doughnut Chart 



 Bar Chart 

 Area Chart 

 XY (Scatter) Chart 

 Bubble Chart 

 Stock Chart 

 Surface Chart 

 Radar Chart 

 Combo Chart 

Each of these chart types have sub-types. In this chapter, you will have an overview of the different chart types 

and get to know the sub-types for each chart type. 

 

Column Chart 

A Column Chart typically displays the categories along the horizontal (category) axis and values along the 

vertical (value) axis. To create a column chart, arrange the data in columns or rows on the worksheet. 

A column chart has the following sub-types − 

 Clustered Column. 

 Stacked Column. 

 100% Stacked Column. 

 3-D Clustered Column. 

 3-D Stacked Column. 

 3-D 100% Stacked Column. 

 3-D Column. 

 

Line Chart 

Line charts can show continuous data over time on an evenly scaled Axis. Therefore, they are ideal for 

showing trends in data at equal intervals, such as months, quarters or years. 

In a Line chart − 

 Category data is distributed evenly along the horizontal axis. 

 Value data is distributed evenly along the vertical axis. 

To create a Line chart, arrange the data in columns or rows on the worksheet. 

A Line chart has the following sub-types − 

 Line 

 Stacked Line 

 100% Stacked Line 

 Line with Markers 

 Stacked Line with Markers 

 100% Stacked Line with Markers 

 3-D Line 

 

 



Pie Chart 

Pie charts show the size of items in one data series, proportional to the sum of the items. The data points in a 

pie chart are shown as a percentage of the whole pie. To create a Pie Chart, arrange the data in one column or 

row on the worksheet. 

A Pie Chart has the following sub-types − 

 Pie 

 3-D Pie 

 Pie of Pie 

 Bar of Pie 

Doughnut Chart 

A Doughnut chart shows the relationship of parts to a whole. It is similar to a Pie Chart with the only 

difference that a Doughnut Chart can contain more than one data series, whereas, a Pie Chart can contain only 

one data series. 

A Doughnut Chart contains rings and each ring representing one data series. To create a Doughnut Chart, 

arrange the data in columns or rows on a worksheet. 

Bar Chart 

Bar Charts illustrate comparisons among individual items. In a Bar Chart, the categories are organized along 

the vertical axis and the values are organized along the horizontal axis. To create a Bar Chart, arrange the data 

in columns or rows on the Worksheet. 

A Bar Chart has the following sub-types − 

 Clustered Bar 

 Stacked Bar 

 100% Stacked Bar 

 3-D Clustered Bar 

 3-D Stacked Bar 

 3-D 100% Stacked Bar 

Area Chart 

Area Charts can be used to plot the change over time and draw attention to the total value across a trend. By 

showing the sum of the plotted values, an area chart also shows the relationship of parts to a whole. To create 

an Area Chart, arrange the data in columns or rows on the worksheet. 

An Area Chart has the following sub-types − 

 Area 

 Stacked Area 

 100% Stacked Area 

 3-D Area 

 3-D Stacked Area 

 3-D 100% Stacked Area 

 



XY (Scatter) Chart 

XY (Scatter) charts are typically used for showing and comparing numeric values, like scientific, statistical, 

and engineering data. 

 

A Scatter chart has two Value Axes − 

 Horizontal (x) Value Axis 

 Vertical (y) Value Axis 

It combines x and y values into single data points and displays them in irregular intervals, or clusters. To 

create a Scatter chart, arrange the data in columns and rows on the worksheet. 

Place the x values in one row or column, and then enter the corresponding y values in the adjacent rows or 

columns. 

Consider using a Scatter chart when − 

 You want to change the scale of the horizontal axis. 

 You want to make that axis a logarithmic scale. 

 Values for horizontal axis are not evenly spaced. 

 There are many data points on the horizontal axis. 

 You want to adjust the independent axis scales of a scatter chart to reveal more information about data 

that includes pairs or grouped sets of values. 

 You want to show similarities between large sets of data instead of differences between data points. 

 You want to compare many data points regardless of the time. 

o The more data that you include in a scatter chart, the better the comparisons you can make. 

A Scatter chart has the following sub-types − 

 Scatter 

 Scatter with Smooth Lines and Markers 

 Scatter with Smooth Lines 

 Scatter with Straight Lines and Markers 

 Scatter with Straight Lines 

 

Bubble Chart 

A Bubble chart is like a Scatter chart with an additional third column to specify the size of the bubbles it 

shows to represent the data points in the data series. 

A Bubble chart has the following sub-types − 

 Bubble 

 Bubble with 3-D effect 

 

Stock Chart 

As the name implies, Stock charts can show fluctuations in stock prices. However, a Stock chart can also be 

used to show fluctuations in other data, such as daily rainfall or annual temperatures. 



To create a Stock chart, arrange the data in columns or rows in a specific order on the worksheet. For example, 

to create a simple high-low-close Stock chart, arrange your data with High, Low, and Close entered as Column 

headings, in that order. 

A Stock chart has the following sub-types − 

 High-Low-Close 

 Open-High-Low-Close 

 Volume-High-Low-Close 

 Volume-Open-High-Low-Close 

 

Surface Chart 

A Surface chart is useful when you want to find the optimum combinations between two sets of data. As in a 

topographic map, colors and patterns indicate areas that are in the same range of values. 

To create a Surface chart − 

 Ensure that both the categories and the data series are numeric values. 

 Arrange the data in columns or rows on the worksheet. 

A Surface chart has the following sub-types − 

 3-D Surface 

 Wireframe 3-D Surface 

 Contour 

 Wireframe Contour 

 

Radar Chart 

Radar charts compare the aggregate values of several data series. To create a Radar chart, arrange the data in 

columns or rows on the worksheet. 

A Radar chart has the following sub-types − 

 Radar 

 Radar with Markers 

 Filled Radar 

 

Combo Chart 

Combo charts combine two or more chart types to make the data easy to understand, especially when the data 

is widely varied. It is shown with a secondary axis and is even easier to read. To create a Combo chart, arrange 

the data in columns and rows on the worksheet. 

A Combo chart has the following sub-types − 

 Clustered Column – Line 

 Clustered Column – Line on Secondary Axis 

 Stacked Area – Clustered Column 

 Custom Combination 



Charts Group 

You can find the Charts group under the INSERT tab on the Ribbon. 

 

The Charts group on the Ribbon looks as follows − 

 

The Charts group is formatted in such a way that − 

 Types of charts are displayed. 

 The subgroups are clubbed together. 

 It helps you find a chart suitable to your data with the button Recommended Charts. 

Chart Tools 

When you click on a chart, a new tab Chart Tools is displayed on the ribbon. There are two tabs under 

CHART TOOLS − 

 DESIGN 

 FORMAT 

 

Recommended Charts 

The Recommended Charts command on the Insert tab helps you to create a chart that is just right for your data. 



 

To use Recommended charts − 

Step 1 − Select the data. 

Step 2 − Click Recommended Charts. 

A window displaying the charts that suit your data will be displayed. 

 

Creating Charts with Insert Chart 

To create charts using the Insert Chart tab, follow the steps given below. 

Step 1 − Select the data. 

Step 2 − Click the Insert tab on the Ribbon. 

Step 3 − Click the Insert Column Chart on the Ribbon. 

 

The 2-D column, 3-D Column chart options are displayed. Further, More Column Charts… option is also 

displayed. 



 

Step 4 − Move through the Column Chart options to see the previews. 

Step 5 − Click Clustered Column. The chart will be displayed in your worksheet. 

 

Step 6 − Give a meaningful title to the chart by editing Chart Title. 

 

Creating Charts with Recommended Charts 

You can use the Recommended Charts option if − 

 You want to create a chart quickly. 

 You are not sure of the chart type that suits your data. 



 If the chart type you selected is not working with your data. 

To use the option Recommended Charts, follow the steps given below − 

Step 1 − Select the data. 

Step 2 − Click the Insert tab on the Ribbon. 

Step 3 − Click Recommended Charts. 

A window displaying the charts that suit your data will be displayed, under the tab Recommended Charts. 

 

Step 4 − Browse through the Recommended Charts. 

Step 5 − Click on a chart type to see the preview on the right side. 

 

Step 6 − Select the chart type you like. Click OK. The chart will be displayed in your worksheet. 

 



If you do not see a chart you like, click the All Charts tab to see all the available chart types and pick a chart. 

Step 7 − Give a meaningful title to the chart by editing Chart Title. 

 

 

Functions of MS Excel 

Various editing and formatting can be done on an Excel spreadsheet. Discussed below are the various features 

of MS Excel.  

The image below shows the composition of features in MS Excel: 

 

 Home 
 Comprises options like font size, font styles, font colour, background colour, alignment, 

formatting options and styles, insertion and deletion of cells and editing options 

 

 Insert 
 Comprises options like table format and style, inserting images and figures, adding graphs, 

charts and sparklines, header and footer option, equation and symbols 

 

 Page Layout 
 Themes, orientation and page setup options are available under the page layout option 

 

 Formulas 
 Since tables with a large amount of data can be created in MS excel, under this feature, you can 

add formulas to your table and get quicker solutions  

 

 Data 
 Adding external data (from the web), filtering options and data tools are available under this 

category 

 

 Review 
 Proofreading can be done for an excel sheet (like spell check) in the review category and a 

reader can add comments in this part  

 

 View 
 Different views in which we want the spreadsheet to be displayed can be edited here. Options to 

zoom in and out and pane arrangement are available under this category 

 



Starting Excel 2007 from the Start menu 

To start Excel 2007, choose Start→All Programs→Microsoft Office→Microsoft Office Excel 2007. A new, 

blank workbook appears, ready for you to enter data. 

 

Excel 2007 displays a new, blank workbook named Book1 when you start the program. 

Pinning Excel 2007 to the Start menu 

If you use Excel all the time, you may want to make its program option a permanent part of the Windows Start 

menu. To do this, you pin the program option to the Start menu: 

1. Click the Start menu and then right-click Microsoft Office Excel 2007 on the Start menu to open its shortcut 

menu. 

If you don‘t see Microsoft Office Excel 2007 displayed on the recently used portion on the left side of the 

Windows Start menu, start Excel 2007 and then repeat this step. 

2. Click Pin to Start Menu on the shortcut menu. 

After pinning Excel in this manner, the Microsoft Office Excel 2007 option always appears in the left-hand 

column of the Start menu, and you can then launch Excel simply by clicking the Start button and then clicking 

this option. 

Excel Work Environment  

There are numbers of spreadsheet programs but from all of them, Excel is most widely used. People have been 

using it for last 30 years and throughout these years, it has been upgraded with more and more features. 

The best part about Excel is, it can apply to many business tasks, including statistics, finance, data management, 

forecasting, analysis, to track inventory & billing, and business intelligence. 

Following are the few things which it can do for you: 

 Number Crunching 

 Charts and Graphs 

 Store and Import Data 

https://careermetis.com/learn-these-9-things-in-microsoft-excel-to-stay-ahead-from-your-colleagues/
https://excelchamps.com/excel-inventory-management-template-user-forms-vba/


 Manipulating Text 

 Templates/Dashboards 

 Automation of Tasks 

 And Much More… 

Three most important components of Excel is which you need to understand first: 

 

1. Cell 

A cell is a smallest but most powerful part of a spreadsheet. You can enter your data into a cell either by typing 

or by copy-paste. Data can be a text, a number, or a date. You can also customize it by changing its size, font 

color, background color, borders, etc. 

Every cell is identified by its cell address, cell address contains its column number and row number (If a cell is 

on 11th row and on column AB, then its address will be AB11). 

2. Worksheet: 

A worksheet is made up of individual cells which can contain a value, a formula, or text. It also has an invisible 

draw layer, which holds charts, images, and diagrams. Each worksheet in a workbook is accessible by clicking 

the tab at the bottom of the workbook window. 

In addition, a workbook can store chart sheets; a chart sheet displays a single chart and is accessible by clicking 

a tab. 

3. Workbook 

A workbook is a separate file just like every other application has. Each workbook contains one or more 

worksheets. You can also say that a workbook is a collection of multiple worksheets or can be a single 

worksheet. 

You can add or delete worksheets, hide them within the workbook without deleting them, and change the order 

of your worksheets within the workbook. 

 

CELL and CELL Address 

Cell 

A spreadsheet is in the form of a table comprising rows and columns. The rectangular box at the intersection 

point between rows and columns forms a cell. Given below is an image of a cell: 

 

 

Cell Address 

The cell address is the name by which is cell can be addressed. For example, if row 7 is interested in column G, 

then the cell address is G7.  



 

Standard Toolbar 

It is a toolbar of important features, such as New, Open, Save, collected in the form of icons that are frequently used for creating 

documents. 

Icon Name Description 

 

New Creates a new document in a new window. 

 

Open Opens a saved document in the worksheet. 

 

Save Saves the current document. 

 

Save as PDF Saves the current document as PDF. 

 

Print Prints the currently document. 

 

Print Preview Shows a print preview of the currently open document. 

 

Cut Cuts the selected content and copies it to the clipboard. 

 

Copy Copies the selected content to the clipboard. 

 

Paste Inserts the contents on the clipboard into the document. 

 

Format Painter Copies formats of selected cells or range of cells to 

specified locations. 

 

Undo Cancels the last action. 

 

Redo Runs the canceled action again. 

 

Find 
Finds the contents of the document that match search 

words. 

 

Replace Opens the Replace dialog box. 

 

Clear Contents Clears contents entered in cells. 

 

Clear Formats Clears formats applied in cells. 

 

Clear All Clears both formats and contents entered in cells. 

 

Insert Inserts a new worksheet. 

 

Insert Hyperlink Creates a hyperlink in the text. 

 

AutoSum 
Adds all numbers in the row or column adjacent to the 

active cell. 

 

Sort Ascending Sorts the contents in the selected range in ascending order. 

 

Sort Descending 
Sorts the contents in the selected range in descending 

order. 

 

Chart Wizard Run the Chart Wizard to insert or modify charts. 

 

Zoom Zooms in and out of the screen. 

 

ThinkFree Office Calc Help Opens ThinkFree Office Calc Help. 

 

Format Toolbar 

The Formatting Toolbar contains a collection of icon buttons that allows the user to access various formatting menus such as 

changing the font or the paragraph format. 

Icon Name Description 

 

Font Changes the font of the selected text. 

 

Font Size Changes the font size of the selected text. 

 

Increase Font Size Increases the font size of the selected text by 1 point. 

 

Decrease Font Size Decreases the font size of the selected text by 1 point. 

 

Bold Changes the selected text to bold. 



 

Italic Changes the selected text to italic. 

 

Underline Underlines the selected text. 

 

Align Left Aligns the selected text to the left of the cell. 

 

Center Aligns the selected text in the center of the cell. 

 

Align Right Aligns the selected text to the right of the cell. 

 

Merge and Center 
Merges selected cells into one, and aligns text in the center of the 
cell. 

 

Currency Style Represents the selected number in the specified currency format. 

 

Percent Style Represents the selected number in percentage format. 

 

Comma Style 
Puts commas between numbers appropriate for the number 
format. 

 

Increase Decimal Increases the number of places to the right of the decimal point. 

 

Decrease Decimal Decreases the number of places to the right of the decimal point. 

 

Decrease Indent Set the paragraph in from the margin. 

 

Increase Indent Set the paragraph out to the margin. 

 

Border Changes the border shape of the selected cell. 

 

Fill Color Fills the selected cell with the specified color. 

 

Font Color Changes the color of the selected text. 

  

Formula Bar 

Formula bar is a bar of items, such as a cell name box, function icon, and function box, that are collected in the form of icons. 

 

Icon Name Description 

 

Name Box Indicates the name of the selected cell. 

 

Enter function icon Returns the result of the function entered in the function box. 

 

Cancel function icon Cancels the function entered in the function box. 

 

Function Wizard Opens the Function dialog box. 

  

Components of an Excel Workbook 

Before you start using it, it‘s really important to understand that what‘s where in its window. So ahead we have 

all the major component which you need to know before entering the world of Microsoft Excel. 

 



1. Active Cell: A cell which is currently selected. It will be highlighted by a rectangular box and its 

address will be shown in the address bar. You can activate a cell by clicking on it or by using your 

arrow buttons. To edit a cell, you double-click on it or use F2 to as well. 

2. Columns: A column is a vertical set of cells. A single worksheet contains 16384 total columns. Every 

column has its own alphabet for identity, from A to XFD. You can select a column clicking on its 

header. 

3. Rows: A row is a horizontal set of cells. A single worksheet contains 1048576 total rows. Every row has 

its own number for identity, starting from 1 to 1048576. You can select a row clicking on the row 

number marked on the left side of the window. 

4. Fill Handle: It‘s a small dot present on the lower right corner of the active cell. It helps you to fill 

numeric values, text series, insert ranges, insert serial numbers, etc. 

5. Address Bar: It shows the address of the active cell. If you have selected more than one cell, then it will 

show the address of the first cell in the range. 

6. Formula Bar: The formula bar is an input bar, below the ribbon. It shows the content of the active cell 

and you can also use it to enter a formula in a cell. 

7. Title Bar: The title bar will show the name of your workbook, followed by the application name 

(―Microsoft Excel‖). 

8. File Menu: The file menu is a simple menu like all other applications. It contains options like (Save, 

Save As, Open, New, Print, Excel Options, Share, etc). 

9. Quick Access Toolbar: A toolbar to quickly access the options which you frequently use. You can add 

your favorite options by adding new options to quick access toolbar. 

10. Ribbon Tab: Starting from the Microsoft Excel 2007, all the options menus are replaced with the 

ribbons. Ribbon tabs are the bunch of specific option group which further contains the option. 

11. Worksheet Tab: This tab shows all the worksheets which are present in the workbook. By default you 

will see, three worksheets in your new workbook with the name of Sheet1, Sheet2, Sheet3 respectively. 

12. Status Bar: It is a thin bar at the bottom of the Excel window. It will give you an instant help once you 

start working in Excel. 

 

Entering data in cell address  

Select a cell with a single click where you want to enter data; cell B3 is selected in the image given below. 

Then double click in the cell to enter data. You can enter text, numbers and formulas in the cell. 

After entering data, you can press Tab key to move to next column and can press Enter key to move to next 

row. You can press arrow keys for more options to move to other cells. 

https://excelchamps.com/excel-basics/excel-formula-bar/
https://excelchamps.com/excel-basics/quick-access-toolbar/


  

1. Move the cell pointer to the required cell and then type the data. While you type the data you will notice 

that it appears both in the worksheet (in the example below, the text appears in cell A1) and in 

the Formula Bar. 

 
2. Press ENTER to enter the information into the cell. Your cell pointer will move down to the cell below. 

 

Making changes to an entry 

To start working in Edit mode, do one of the following: 

 Double-click the cell that contains the data that you want to edit. 

This starts Edit mode and positions the cursor in the cell in the location that you double-clicked. The cell 

contents are also displayed in the formula bar. 

 Click the cell that contains the data that you want to edit, and then click anywhere in the formula bar. 

This starts Edit mode and positions the cursor in the formula bar at the location that you clicked. 

 Click the cell that contains the data that you want to edit, and then press F2. 

This starts Edit mode and positions the cursor at the end of the cell contents. 

 

Mathematical Calculations 

Functions in Formula 

Many formulas you create use available worksheet functions. These functions enable you to greatly enhance the 

power of your formulas and perform calculations that are difficult if you use only the operators. For example, 

you can use the LOG or SIN function to calculate the Logarithm or Sin ratio. You can‘t do this complicated 

calculation by using the mathematical operators alone. 

Using Functions 

When you type = sign and then type any alphabet you will see the searched functions as below. 



 

Suppose you need to determine the largest value in a range. A formula can‘t tell you the answer without using a 

function. We will use formula that uses the MAX function to return the largest value in the range B3:B8 

as =MAX(A1:D100). 

 

Another example of functions. Suppose you want to find if the cell of month is greater than 1900 then we can 

give Bonus to Sales representative. The we can achieve it with writing formula with IF functions 

as =IF(B9>1900,"Yes","No") 

 

 

Functions by Categories 

Let us see some of the built in functions in MS Excel. 

 Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 



o TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied text string. 

o MID − Returns a specified number of characters from the middle of a supplied text string 

o RIGHT − Returns a specified number of characters from the end of a supplied text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a supplied text 

string (case-sensitive). 

 Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that represents the date in 

Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that represents the time in 

Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

 Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given criteria. 

o SUM − Returns the sum of a supplied list of numbers 

 Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of the conditions 

evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of the conditions 

evaluate to TRUE, or FALSE otherwise. 

o NOT − Returns a logical value that is the opposite of a user supplied logical value or expression 

i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the supplied argument 

is FAL 

 Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 

 



Formulas using numbers 

S.No. Function and Description 

1 
ABS 

Returns the absolute value of a number 

2 
ACOS 

Returns the arccosine of a number 

3 
ACOSH 

Returns the inverse hyperbolic cosine of a number 

4 
ACOT 

Returns the arccotangent of a number 

5 
ACOTH 

Returns the hyperbolic arccotangent of a number 

6 
AGGREGATE 

Returns an aggregate in a list or database 

7 
ARABIC 

Converts a Roman number to Arabic, as a number 

8 
ASIN 

Returns the arcsine of a number 

9 
ASINH 

Returns the inverse hyperbolic sine of a number 

10 
ATAN 

Returns the arctangent of a number 

11 
ATAN2 

Returns the arctangent from x and y coordinates 

12 
ATANH 

Returns the inverse hyperbolic tangent of a number 

13 
BASE 

Converts a number into a text representation with the given radix (base) 

14 
CEILING.MATH 

Rounds a number up, to the nearest integer or to the nearest multiple of significance 

15 
COMBIN 

Returns the number of combinations for a given number of objects 

16 
COMBINA 

Returns the number of combinations with repetitions for a given number of items 

17 
COS 

Returns the cosine of a number 

18 
COSH 

Returns the hyperbolic cosine of a number 

https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_abs_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_acos_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_acosh_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_acot_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_acoth_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_aggregate_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_arabic_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_asin_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_asinh_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_atan_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_atan2_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_atanh_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_base_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_ceilingmath_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_combin_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_combina_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_cos_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_cosh_function.htm


19 
COT 

Returns the cotangent of an angle 

20 
COTH 

Returns the hyperbolic cotangent of a number 

21 
CSC 

Returns the cosecant of an angle 

22 
CSCH 

Returns the hyperbolic cosecant of an angle 

23 
DECIMAL 

Converts a text representation of a number in a given base into a decimal number 

24 
DEGREES 

Converts radians to degrees 

25 
EVEN 

Rounds a number up to the nearest even integer 

26 
EXP 

Returns e raised to the power of a given number 

27 
FACT 

Returns the factorial of a number 

28 
FACTDOUBLE 

Returns the double factorial of a number 

29 
FLOOR.MATH 

Rounds a number down, to the nearest integer or to the nearest multiple of significance 

30 
GCD 

Returns the greatest common divisor 

31 
INT 

Rounds a number down to the nearest integer 

32 
LCM 

Returns the least common multiple 

33 
LN 

Returns the natural logarithm of a number 

34 
LOG 

Returns the logarithm of a number to a specified base 

35 
LOG10 

Returns the base-10 logarithm of a number 

36 
MDETERM 

Returns the matrix determinant of an array 

37 
MINVERSE 

Returns the matrix inverse of an array 

https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_cot_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_coth_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_csc_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_csch_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_decimal_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_degrees_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_even_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_exp_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_fact_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_factdouble_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_floormath_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_gcd_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_int_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_lcm_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_ln_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_log_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_log10_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_mdeterm_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_minverse_function.htm


38 
MMULT 

Returns the matrix product of two arrays 

39 
MOD 

Returns the remainder from division 

40 
MROUND 

Returns a number rounded to the desired multiple 

41 
MULTINOMIAL 

Returns the multinomial of a set of numbers 

42 
MUNIT 

Returns the unit matrix or the specified dimension 

43 
ODD 

Rounds a number up to the nearest odd integer 

44 
PI 

Returns the value of pi 

45 
POWER 

Returns the result of a number raised to a power 

46 
PRODUCT 

Multiplies its arguments 

47 
QUOTIENT 

Returns the integer portion of a division 

48 
RADIANS 

Converts degrees to radians 

49 
RAND 

Returns a random number between 0 and 1 

50 
RANDBETWEEN 

Returns a random number between the numbers that you specify 

51 
ROMAN 

Converts an Arabic numeral to Roman, as text 

52 
ROUND 

Rounds a number to a specified number of digits 

53 
ROUNDDOWN 

Rounds a number down, toward 0 

54 
ROUNDUP 

Rounds a number up, away from 0 

55 
SEC 

Returns the secant of an angle 

56 
SECH 

Returns the hyperbolic secant of an angle 
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57 
SERIESSUM 

Returns the sum of a power series based on the formula 

58 
SIGN 

Returns the sign of a number 

59 
SIN 

Returns the sine of the given angle 

60 
SINH 

Returns the hyperbolic sine of a number 

61 
SQRT 

Returns a positive square root 

62 
SQRTPI 

Returns the square root of pi 

63 
SUBTOTAL 

Returns a subtotal in a list or database 

64 
SUM 

Adds its arguments 

65 
SUMIF 

Adds the cells specified by a given criteria 

66 
SUMIFS 

Adds the cells specified by a multiple criteria 

67 
SUMPRODUCT 

Returns the sum of the products of corresponding array components 

68 
SUMSQ 

Returns the sum of the squares of the arguments 

69 
SUMX2MY2 

Returns the sum of the difference of squares of corresponding values in two arrays 

70 
SUMX2PY2 

Returns the sum of the sum of squares of corresponding values in two arrays 

71 
SUMXMY2 

Returns the sum of squares of differences of corresponding values in two arrays 

72 
TAN 

Returns the tangent of a number 

73 
TANH 

Returns the hyperbolic tangent of a number 

74 
TRUNC 

Truncates a number (you specify the precision of the truncation) 

 

  

https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_seriessum_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sign_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sin_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sinh_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sqrt_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sqrtpi_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_subtotal_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sum_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumif_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumifs_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumproduct_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumsq_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumx2my2_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumx2py2_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_sumxmy2_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_tan_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_tanh_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_math_trignometric_trunc_function.htm


Formula using Cell address 
 

Cell References in Formulas 

Most formulas you create include references to cells or ranges. These references enable your formulas to work 

dynamically with the data contained in those cells or ranges. For example, if your formula refers to cell C2 and 

you change the value contained in C2, the formula result reflects new value automatically. If you didn‘t use 

references in your formulas, you would need to edit the formulas themselves in order to change the values used 

in the formulas. When you use a cell (or range) reference in a formula, you can use three types of references − 

relative, absolute, and mixed references. 

 

Relative Cell References 

The row and column references can change when you copy the formula to another cell because the references 

are actually offsets from the current row and column. By default, Excel creates relative cell references in 

formulas. 

 
 

Absolute Cell References 

The row and column references do not change when you copy the formula because the reference is to an actual 

cell address. An absolute reference uses two dollar signs in its address: one for the column letter and one for the 

row number (for example, $A$5). 

 
 

Mixed Cell References 

Both the row or column reference is relative and the other is absolute. Only one of the address parts is absolute 

(for example, $A5 or A$5). 

 



UNIT-III: 

MS WORD                   (L-7+T-2 HOURS) 

Understanding Word Processing: Word Processing Basics; Opening and Closing of documents; Text creation 

and Manipulation; Formatting of text; Table handling; Spell check, language setting and thesaurus; Printing of 

word document. 

MS WORD 

Microsoft Word is a word processing application that is part of the Microsoft Office Suite. Microsoft 

Office Suite is a set of powerful applications that are designed to provide a rich set of tools for almost 

every conceivable business task for a small (and large) business or organization. Microsoft Office Suite 

has been designed so that the interface across all the applications is consistent. Obviously, this helps users 

to move from application to application to carry out their various business tasks. The primary applications 

that are included in Microsoft Office include the following: 

 Microsoft Word—A word processing application to create and edit letters, articles, newsletters, flyers, 

and any other text-based document. 

 

Open & Create a new document 

When you create a document in Microsoft Word Starter 2010, you can start from scratch or you can start from a 

template, where some of the work is already done for you. 

1. Click File, and then click New. 

 

2. If you want to start with the equivalent of a blank piece of paper, double-click Blank document. 

 

If you want a head-start on a particular kind of document, choose one of the templates available from 

Office.com. 



 

3. Word Starter opens the blank document or template, ready for you to add your content. 

Save a document 

When you interrupt your work or quit, you must save your document, or you will lose your work. When you 

save your document, the document is saved as a file on your computer, where you can open it later to modify it 

and print it. 

1. Click Save on the Quick Access Toolbar. 

(Keyboard shortcut: Press CTRL+S.) 

If this document was already saved as a file, any changes you made are immediately saved in the document, 

and you can continue working. 

2. If this is a new document that you have not yet saved, type a name for it. 

3. Click Save. 

Closing a document / file 

When you attempt to close a document, Word will ask you if you want to save it first (see save file). This is a 

safety measure so that you do not accidentally close files without saving them. If you want to keep a file, you 

must save it before closing it. 

To close a file (assuming that you have saved it) 

Click on File 

Click on Close 

 

http://colfinder.net/materials/Supporting_Distance_Education_Through_Policy_Development/skill/word/save.htm


There is not normally an icon available on the toolbar for this function. The other way in which you can 

close a file is to use the buttons on the very top right of the screen. Notice that one set of buttons appears 

in the blue status bar. This is not the set of button that I am referring to (these buttons refer to the whole 

programme and that X will close the Word programme). 

 

The buttons being referring to are the second row of buttons in the grey area. See the circle around 

the X that we are referring to (above). The second row of buttons refer to the document with which you 

are working. If you want to close the document, carefully click on that X in the second row. 

 

Text Manipulation  

Describe how to change the appearance of a document by text manipulation Text manipulation usually refers to 

the ability to change words, sentences and paragraphs which have been typed. The manipulation can involve the 

changing of the characters (letters and symbols), adding line breaks, direction of the text and changing the case 

(CAPITAL letter or small letter) of the characters 

 

Formatting of text  

Whether you start your document from a blank page or a template, you add content of your own by typing text 

and formatting it. You can apply formatting to whole paragraphs, as well as to particular words or phrases, to 

make them stand out. 

1. Type your text. 

The positioning and font of the text depends on the settings of the template you are using. Even a blank 

document has settings for how the text looks. 

By default, Word Starter displays text in a blank document in the Calibri, 11-point font. Paragraphs are aligned 

on the left, with a blank line between paragraphs. 

2. To make the document easier to read quickly, try adding headings that label where you're switching to a new 

topic. 

Type the heading, and press ENTER. 

3. Click anywhere in the heading you just typed, and then in the Styles group on the Home tab, point to (but don't 

click) Heading 1. 

4. Word Starter shows you a preview of what your heading would look like if you clicked Heading 1. 

 

5. Click the More down-arrow next to the style gallery, and point to the various styles. 



 

Notice that the styles called Heading, Title, Subtitle, Quote, Intense Quote, and List Paragraph affect the 

whole paragraph, while the other styles affect only the word where your cursor is positioned. 

Styles are predefined formats, designed to work together to give your document a polished look. 

6. Click to apply a style you like. 

To supplement the formatting you can do with the gallery of styles, you can select the text you want to format, 

and then choose a command from the Font group of the Home tab. 

 

You have many choices here, including: 

 Bold 

 Italics 

 Underline 

 Strikethrough 

 Subscript 

 Superscript 

 Color 

 Size 

 

Table Handling 

Tables give you a way to arrange content in rows and columns. This is a handy way to present information that 

is categorized or grouped, such as shirt sizes for your team, price and other criteria for items on a shopping list, 

or phone numbers and e-mail addresses for a list of contacts. 

1. Click where you want to insert a table. 

2. On the Insert tab, in the Tables group, click Table, and then drag to select the number of rows and columns 

that you want. 

 

3. Type your text in the table. If you need more rows, press TAB when you reach the end of the existing table. 

To give the table a polished look, use the gallery of table styles to format it. 

1. Click anywhere in the table, and then on the Design tab, within the Table Tools tab, point to (but don't click) 

the various table styles in the gallery. 

Word Starter displays what the table will look like when you click one of the table styles. 



 

2. To switch header-row formatting off, clear the Header Row check box in the Table Style Options group. 

Experiment with switching the other options off. When you find the table style you like, click it. 

 

How to add, modify, or delete a table in Microsoft Word 

 

You can insert a table in a Microsoft Word document to display data in a tabular format. A table is a great way 

to represent multiple fields of associated data. For example, a list of prices is easier to read when displayed in a 

table. 

You can also create a table in Microsoft Excel and then copy and paste that table in a Microsoft Word 

document, keeping all the same formatting. See: How to insert and customize a table in Microsoft Excel. 

 

Adding a table in Word 

1. In Word, place the mouse cursor where you want to add the table. 

2. Click the Insert tab in the Ribbon. 

3. Click the Table button and select how many cells, rows, and columns you want the table to 

display. You can also click Insert Table and enter the number of columns and rows for the 

inserted table. 

Inserting or deleting a row or column 

In a Microsoft Word table, you can add or remove a row or column at any time. 

 Insert a row. 

 Insert a column. 

 Delete a row. 

 Delete a column. 
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Insert a row 

1. Move the mouse cursor inside the left edge of a cell in the row where you want to insert a new 

row. The cursor changes to a small black arrow pointing to the top-right. 

2. Using your mouse, right-click to open the pop-up menu, select Insert, then select Insert Rows 

Above or Insert Rows Below, depending where you want to insert the row. 

 

Insert a column 

1. Move the mouse cursor inside the left edge of a cell in the column where you want to insert a 

new column. The cursor changes to a small black arrow pointing to the top-right. 

2. Using your mouse, right-click to open the pop-up menu, select Insert, then select Insert 

Columns to the Left or Insert Columns to the Right, depending where you want the row 

inserted. 

 

Delete a row 

1. Move the mouse cursor inside the left edge of a cell in the row you want to delete. The cursor 

changes to a small black arrow pointing to the top-right. 

2. Using your mouse, double-click to select the entire row in the table. 

3. Right-click with the mouse to open the pop-up menu, and select Delete Rows. 

 



Delete a column 

1. Move the mouse cursor inside the top edge of the top-most cell in the column you want to 

delete. The cursor changes to a small black arrow pointing downward. 

2. Using your mouse, click once to select the entire column in the table. 

3. Right-click with the mouse to open the pop-up menu, and select Delete Columns. 

 

Moving the table 

After the table is added to the document, you can move it anywhere else in the document. To move the table, 

hover your mouse cursor over the table, then click-and-drag the arrows in the top-left corner of the table. 

 

Resizing the table 

Once the table is inserted, you can adjust the table's size by moving the mouse to the bottom-right corner of the 

table until you get a double-headed arrow. Once this arrow is visible, click-and-drag the table in the direction 

you want the table to expand. 

 

Changing the look of the table 

After the table is added to the document, move your cursor to a cell in the table, and click the Design tab. In 

the Design tab, you can adjust the Header Row, Total Row, and how the rows appear. You can also adjust the 

overall look of the table by clicking one of the table styles. 

Repeat header row of the table on each page 

If the table spans more than one page, you may want to have the header row displayed on each additional page 

the table spans across. You can make the header row visible on each page by following the steps below. 

1. Right-click the header row of the table and select Properties in the pop-up menu. 

2. In the Table Properties window, click the Row tab. 

3. Check the box for the Repeat as header row at the top of each page option, and click OK. 
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Deleting a table 

If you want to delete a table from a Word document, follow the steps below. 

1. Move your mouse cursor over the table you want to delete. 

2. At the upper-left corner of the table, a small square with the move icon  inside it should be 

seen. Move your mouse cursor over that icon and click it to select the entire table. 

 

3. Right-click anywhere in the table and select Delete Table in the pop-up menu. 

 

Spell Check: 

Checking the spelling of your document is a quick, easy way to save yourself embarrassment of typographical 

errors and misspellings in your document. 

As you type, Word Starter marks spelling errors with a red, wavy underline. You can correct these by right-

clicking the word and then clicking the correctly spelled word (or click Ignore if you want Word Starter to skip 

over this word, or click Add to Dictionary if this is a spelling you want to mark as being correct). 

Word Starter marks grammatical errors with a green, wavy underline. Correct these in the same way as you 

correct spelling errors (click the correction that Word Starter suggests, or click Ignore Once). 

Word Starter marks contextual spelling errors with a blue, wavy underline. These are words that are spelled 

correctly, but are not likely the word you mean. For example, in English, you might type, "Let me no." The 

word "no" is spelled correctly, but the word you meant is "know." Right-click the word, and click the correct 

spelling (or click Ignore to skip it). 

 

If you want to check spelling throughout the document, on the Home tab, click Spelling. 

(Keyboard shortcut: Press F7.) 

Check Spelling and Grammar in Microsoft Word 

It is important to always check your documents for spelling and grammar mistakes before distribution. 

Fortunately, Word makes it easy. 

This feature works the same in all modern versions of Microsoft Word. 

1. From the Proofing group on the Review tab, select Spelling & Grammar.

 
2. Microsoft Word will look for spelling and grammar errors starting from the location of your cursor in 

the document. 
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3. If Word finds a spelling error, a navigation pane similar to the one below will appear: You then have the 

following options: 

o Ignore. To leave the text as is in a specific instance, but be notified if Microsoft Word finds the 

same thing again, click Ignore. 

o Ignore All. To leave the text as is in this and future instances, click Ignore All. 

o Add. Adding a word to your dictionary will prevent Microsoft Word from ever noting this word 

as being misspelled again. 

o Change. To correct only this instance of the misspelling, click Change. 

o Change All. To correct all instances of the misspelling throughout the document, click Change 

All. 

4. If Word finds a grammar error, a dialog box similar to the one below will appear 

:  

o Ignore. To leave the text as is in a specific instance, but be notified if Microsoft Word finds the 

same thing again, click Ignore. 

o Change. To accept Word's suggested correction, click Change. 

o At the bottom of the pane, you will see an explanation of the grammar error that Word has 

detected. 

 

A useful feature when checking spelling and grammar is Word's AutoCorrect feature. When Word indicates a 

word in a document may be misspelled or incorrect, with a squiggle under it, you can right-click the word to see 

suggestions. If a suggestion is correct, simply select it to replace the word. 

 

Auto correction 

To automatically correct common errors as you type, use the options in the AutoCorrect tab of 

the AutoCorrect dialog box to set up automatic correction of capitalization errors and commonly misspelled 

words. You can also create special characters. Several options are preset with Word, but you can delete and 

modify existing entries. This document discusses the options available and how to make changes. 



Accessing the AutoCorrect Dialog Box 

Windows: 

From the File menu, click WORD OPTIONS  

The Word Options dialog box opens. 

 

In the Categories pane, select Proofing 

Under AutoCorrect options, click AUTOCORRECT OPTIONS... 

The AutoCorrect dialog box appears. 

 

Macintosh: 

From the Word menu, select Preferences... 

The Word Preferences dialog box appears. 

 

In the Authoring and Proofing Tools section, click AUTOCORRECT  

The AutoCorrect dialog box appears. 



 

Selecting/Deselecting AutoCorrect Options 

You can use the AutoCorrect options that are appropriate for your work while turning off the others. This table 

shows the options and the automatic corrections Word makes when they are selected. These options can also be 

changed through the use of smart tags. 

Access the AutoCorrect dialog box 

Select the AutoCorrect tab  

The AutoCorrect options are preceded by checkboxes. 

Select the options you want to activate  

NOTE: A checkmark in the box indicates an option is selected and active. 

Click OK 

AutoCorrect Options 

The AutoCorrect dialog box offers the following customization options. 

 

Option Selected What You Type AutoCorrection 

Correct TWo INitial CApitals TOday's meeting was cancelled. Today's meeting was cancelled. 

Capitalize first letter of sentences departmental budgets are due. Departmental budgets are due. 

Capitalize first letter of table cells total cost Total cost 

Capitalize names of days Our staff will meet thursday. Our staff will meet Thursday. 

Windows only: Correct accidental 

usage of CAPS LOCK key 

tHE GRADES HAVE BEEN 

TURNED IN. 

The grades have been turned in. 

Replace text as you type Your their academic advisor. You're their academic advisor. 

Automatically use suggestions from 

the spelling checker 

n/a Works in conjunction with 

the Replace text as you 

type option, replacing misspelled 

text with words from Word's 

dictionary. 

Accidental usage of Caps Lock key correction: 
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Correction occurs if the first letter is typed lowercase and following letters are uppercase, which is the case 

when Caps Lock is on and you press [Shift] to capitalize the first letter of a word. The correction makes the first 

letter uppercase and then turns off the Caps Lock. No correction will occur if the first letter is typed in caps. 

Creating Exceptions to AutoCorrect Options 

The AutoCorrect feature can save you time during editing. However, if you have special abbreviations or 

company names that are exceptions to the rules Word uses in determining corrections, the AutoCorrect feature 

may seem like a nuisance. Word allows you to record these exceptions so you can take advantage of 

the AutoCorrect feature without worrying about words or phrases particular to your work. 

First Letter 

Word normally capitalizes the next word after a period and a space. For example, if you use the 

abbreviation num. for number and type num. five, Word will correct it to num. Five. You can record your 

abbreviation as an exception so Word will not make the correction. 

INitial Caps 

Word will automatically correct two initial capital letters. However, if you use a word or company name that 

has two initial capital letters, you would not want the correction made. For example, if you correspond with a 

company called REmax, when you type the name, Word will correct it to Remax. You can record a name or 

term as an exception so Word will not correct it. 

NOTE: Word does not correct two initial capital letters followed by a lowercase s (e.g., RNs). 

To record exceptions: 

Access the AutoCorrect dialog box 

Select the AutoCorrect tab 

Click EXCEPTIONS... 

The AutoCorrect Exceptions dialog box appears. 

Select the appropriate tab 

In the text box, type your exception 

Click ADD 

Click OK 

Windows: You are returned to Word Options dialog box. 

Macintosh: You are returned to the AutoCorrect dialog box. 

Click OK 

You are returned to the document. 

Overriding AutoCorrect 

Word may sometimes automatically "correct" a word or phrase that you do not want changed. If you do not use 

the word often enough to warrant creating an exception, you can undo the individual AutoCorrection without 

changing AutoCorrect settings. You may also use this method to override AutoFormatting such as bulleted and 

numbered lists. 

Move your mouse over the AutoCorrected word A small rectangle appears under the first letter. 

 



Move your mouse over this rectangle A Smart Tag appears. 

Click the  » select the desired AutoCorrect option  

 

Your options and the implications are listed here, using the example of automatically correcting a misspelled 

word. 

For more information about Smart Tags, refer to The Office 2007 Environment: Smart Tags. 

Some AutoCorrect options include: 

Undo Automatic Capitalization Selecting this option affects only this occurrence of the capitalization in the 

current document 

Stop Auto-capitalizing First Letter of Sentences Selecting this option corrects this occurrence and turns off 

this option for all documents 

Windows: Control AutoCorrect Options... Macintosh: Control AutoFormat Options... 

Selecting this option takes you to the AutoCorrect dialog box, where you can choose from multiple 

AutoCorrect options that will affect all documents 

 

Setting AutoFormat 

The following steps will help you set the AutoFormat feature in your Microsoft Word. 

Step 1 − Click the File tab, click Options, and then click the Proofing option available in the left most 

column, it will display the Word Options dialog box. 

 

Step 2 − Click the AutoCrrect Options button; this will display the AutoCorrect dialog box and then click 

the AutoFormat As You Type tab to determine what items Word will automatically format for you as you 

type. 

 

Step 3 − Select from among the following options, depending on your preferences. 

 

S.No Option and Description 

1 
"Straight quotes" with ―smart quotes‖ 
This option will be used to replace the plain quotation characters with curly quotation characters. 

2 
Fractions (1/2) with fraction character (½) 
This option will be used to replace the fractions typed with numbers and slashes with fraction 

characters. 

3 
*Bold* and _italic_ with real formatting 
This option will be used to format text enclosed within asterisks (*) as bold and text enclosed 

within underscores ( _ ) as italic. 

4 
Internet and network paths with hyperlinks 
This option will be used to format e-mail addresses and URLs as clickable hyperlink fields. 
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5 
Ordinals (1st) with superscript 
This option will be used to format ordinal numbers with a superscript like 1st becomes 1

st
. 

6 
Hyphens (--) with dash (—) 
This option will be used to replace a single hyphen with an en dash (.) and two hyphens with an em 

dash (—). 

7 

Automatic bulleted lists 
This option will be used to apply bulleted list formatting to paragraphs beginning with *, o, or - 

followed by a space or tab character. 

8 
Automatic numbered lists 
This option will be used to apply numbered list formatting to paragraphs beginning with a number 

or letter followed by a space or a tab character. 

9 
Border lines 
This option will be used to apply paragraph border styles when you type three or more hyphens, 

underscores, or equal signs (=). 

10 
Tables 
This option will be used to create a table when you type a series of hyphens with plus signs to 

indicate the column edges. Try with +-----+------+ ) and then press Enter. 

11 
Built-in heading styles 
This option will be used to apply heading styles to heading text. 

12 
Format beginning of list item like the one before it 
This option will be used to replace plain quotation characters with curly quotation characters. 

13 
Set left- and first-indent with tabs and backspaces 
This option sets left indentation on the tab ruler based on the tabs and backspaces you type. 

14 
Define styles based on your formatting 
This option automatically creates or modifies styles based on manual formatting that you apply to 

your document. 

Step 4 − Finally click OK to close the AutoCorrect Options dialog box and again click OK to close 

the Word Options dialog box. 

 

Printing of Word document 

Margin Setting 

In this chapter, we will discuss how to adjust page margins in Word 2010. Margins are the space between the 

edge of the paper and the text. You can adjust the right, left, top, and bottom margins of your document. By 

default, Word sets all margins left, right, top, and bottom to 1 inch. 

In the screenshot given below, I have shown top, left and right margins, if you will type the complete page, 

word will leave 1-inch bottom margin as well. 



 

 

Adjust Margins 

The following steps will help you understand how to set margins for an open document. 

Step 1 − Open the document the margins of which need to be set. If you want the margins to be applied only 

to a selected part of a document, select that particular part. 

Step 2 − Click the Page Layout tab, and click the Margins button in the Page Setup group. This will display 

a list of options to be selected but you have to click the Custom Margins option available at the bottom. 

You can also select any of the predefined margins from the list, but using custom margins option you will have 

more control on all the settings. 

 

Step 3 − You will have to display a Page Dialog Box as shown below where you can set top, left, right and 

bottom margins under the Margins Tab. Select the Apply to: option to apply the margin on selected text or 

complete document. 

 



Step 4 − If you are going to bind the document and want to add an extra amount of space on one edge for the 

binding, enter that amount in the Gutter text box, and select the side the gutter is on with the Gutter 

Position drop-down list. After setting all the desired values for all the margins, click the OK button to apply 

the margins. 

 

Add Header and Footer 

The following steps will help you understand how to add header and footer in a Word document. 

Step 1 − Click the Insert tab, and click either the Header button or the Footer button that which needs to be 

added first. Assume you are going to add Header; when you click the Header button it will display a list of 

built-in Headers from where you can choose any of the headers by simply clicking on it. 

 

Step 2 − Once you select any of the headers, it will be applied to the document in editable mode and the text in 

your document will appear dimmed, Header and Footer buttons appear on the Ribbon and a Close Header 

and Footer button will also appear at the top-right corner. 

 

Step 3 − Finally, you can type your information whatever you want to have in your document header and once 

you are done, click Close Header and Footer to come out of the header insertion mode. You will see the final 

result as follows. 



 

You can follow a similar procedure to add footer in your document. 

Edit Header and Footer 

The following steps will help you understand how to edit the existing header or footer of your document. 

Step 1 − Click the Insert tab, and click either the Header button or Footer button or whatever you want to 

edit. Assume you are going to edit the Header, so when you click the Header button it will display a list of 

options including the Edit Header option. 

 

Step 2 − Click on the Edit Header option and Word will display the editable header as shown in the following 

screenshot. 

 

Step 3 − Now you can edit your document header and once you are done, click Close Header and Footer to 

come out of the edit header mode. 

You can follow a similar procedure to edit the footer in your document. 



 

Adjust page margins 

Adjusting margins on the page gives you more or less blank space between the content of your document and 

the edges of the page. By default, Word Starter sets all margins at one inch. Narrower margins fit more content 

on the page than wider margins, but blank space makes the document easier on the eye. 

You decide whether you want to use the default margin settings or whether another setting will make the 

document look the way you want. 

1. On the Page Layout tab, click Margins. 

 

2. Click one of the pre-set configurations, or to make your own configuration, click Custom Margins, and then 

set dimensions in the Top, Bottom, Left, and Right boxes. 

Notes:  

 You can lay out the page horizontally instead of veritcally—for example, if your document includes a wide 

table. For a horizontal page, on the Page Layout tab, in the Page Setup group, click Orientation, and then 

click Landscape. 

 

 By default, the U.S. English version of Word Starter uses inches to specify dimensions such as page margins. If 

you would rather use metric or typesetting units, click the File tab, click Options, click Advanced, and then 

under Display, choose the units you want to use in the Show measurements in units of box. 

 

Printing Documents  

Before you print a document, it's a good idea to preview it to make sure that it looks the way you want. When 

you preview a document in Word Starter, it opens in the Microsoft Office Backstage view. In this view, you can 

change some page setup options before you print. 

1. Click File, and then click Print. 

Keyboard shortcut. You can also press CTRL+P. 

Note: The preview window displays black and white, regardless of whether your document includes color, 

unless you are using a printer that can print color. 

2. To preview the next and previous pages, at the bottom of the Print Preview window, click Next 

Page and Previous Page. 

3. Click Print. 



The following steps will help you print your Microsoft Word document. 

Step 1 − Open the document for which you want to see the preview. Next click the File tab followed by 

the Print option which will display a preview of the document in the right column. You can scroll up or scroll 

down your document to walk through the document using given Scrollbar. The middle column gives various 

options to be set before you send your document to the printer. 

 

Step 2 − You can set various other printing options available. Select from among the following options, 

depending on your preferences. 

 

S.No Option and Description 

1 
Copies 
Set the number of copies to be printed; by default, you will have one copy of the document. 

2 

Print Custom Range 
This option will be used to print a particular page of the document. Type the number in Pages option, if 

you want to print all the pages from 7 till 10 then you would have to specify this option as 7-10 and 

Word will print only 7
th

, 8
th

, 9
th

 and 10
th

 pages. 

3 
Print One Sided 
By default, you print one side of the page. There is one more option where you will turn up your page 

manually in case you want to print your page on both sides of the page. 

4 
Collated 
By default, multiple copies will print Collated; if you are printing multiple copies and you want the 

copies uncollated, select the Uncollated option. 

5 
Orientation 
By default, page orientation is set to Portrait; if you are printing your document in landscape mode then 

select the Landscape mode. 



6 
A4 
By default, the page size is A4, but you can select other page sizes available in the dropdown list. 

7 

Custom Margin 
Click the Custom Margins dropdown list to choose the document margins you want to use. For 

instance, if you want to print fewer pages, you can create narrower margins; to print with more white 

space, create wider margins. 

8 
1 Page Per Sheet 
By default, the number of pages per sheet is 1 but you can print multiple pages on a single sheet. Select 

any option you like from the given dropdown list by clicking over the 1 Page Per Sheet option. 

Step 3 − Once you are done with your setting, click on the Print button which will send your document to the 

printer for final printing. 

 

 

 

  



 

UNIT-IV: 

POWERE POINT                                  (L-6 + T-3 HOURS) 

Making Small Presentation: Basics of presentation software; Creating Presentation; Preparation and 

Presentation of Slides; Slide Show; Taking printouts of presentation / handouts. 

 

Basics of Presentation 

Powerpoint 

Microsoft PowerPoint, usually just called the PowerPoint, is a software program developed by Microsoft to 

produce effective presentations. It is a part of Microsoft Office suite. The program comprises slides and various 

tools like word processing, drawing, graphing and outlining. Thus it can display text, table, chart, graphics and 

media in the slides. 

The basic purpose of a PowerPoint presentation is to communicate information or media through a series of 

slides. Along with regular text, your slides can contain numerous types of content such as tables, images, 

drawings, charts, links, word art, videos, audio and even embedded add-ins from Microsoft. The software also 

has built-in editing tools that you can use to resize, position and update content without needing to open items 

in other applications. 

 

Features of PowerPoint 

Microsoft PowerPoint is a professional presentation program that allows the user to create a "presentation slide" 

that can be displayed on the computer screen through a projector that is plugged into the computer. There are 

three main features of the Microsoft PowerPoint window that you need to focus upon while learning 

PowerPoint. These features are Microsoft Office Button, Quick Access Toolbar and Ribbon. Some of the other 

important features of PowerPoint are: 

 Ribbon: PowerPoint has a new, intuitive user interface called the Ribbon that helps you create better 

presentations much more quickly than you could in earlier versions of PowerPoint. 

 Live Preview: PowerPoint takes advantage of the live preview feature to review your formatting choices 

before you apply them. 

 Create Dynamic Presentations: PowerPoint quickly creates dynamic and great looking presentations 

using the redesigned user interface and new graphics capabilities. 



 Video Capabilities: One of the attractive features of Microsoft PowerPoint is that it allows you to use 

video in your presentations. With this software, you can embed a video clip into one of your slides and 

use it during the slideshow. When you embed the video, you can also perform a number of editing 

functions which will allow you to alter the video to your needs for the presentation. 

 Apply a consistent look and feel in one click: PowerPoint themes help you change the look and feel of 

your entire presentation with just one click. PowerPoint comes with new themes, layouts and Quick 

Styles that offer you a wide range of options when you are formatting your presentations. Changing the 

theme of your presentation not only changes the background colour but the colour of a diagram, table 

etc and even the style of any bullet points within a presentation. 

 Sharing: Another feature of Microsoft PowerPoint is the ability to share presentations with other 

individuals in different locations. 

 Dynamically modify shapes, text, and graphics with new tools and effects: You can now manipulate and 

work with your text, tables, charts and other presentation elements in much richer ways than ever 

before. 

 Special Effects: When creating a presentation, one of your jobs as a presenter is to keep the attention of 

your audience. If you create a plain presentation without any flair, your subjects may not pay attention 

for long. With Microsoft PowerPoint, you can use a number of special effects to enhance the quality of 

your presentations. 

 Reduce your document sizes and improve file recovery at the same time: The new compressed 

Microsoft PowerPoint XML Format offers a dramatic reduction in file size, while offering an 

improvement in data recovery for damaged files. 

 Support other file formats: PowerPoint enables support for other file formats, such as PDF and XPS. 

  

Creating Presentation; Preparation and Presentation of Slides; Slide Show: 
 

Creating a Presentation 

When you open PowerPoint window by default a slide appears. The slide has two placeholders or text boxes. 

Additional text boxes can be added from the Insert tab. 

To start creating presentation click on the placeholder or text box a blinking cursor will appear. Then type the 

title and click outside the box. The text box will disappear. 

See the image. 

 



In a similar way, add text or subtitle to the other text box. 

10 Sec 

See the image: 

 

Click outside the text box and the slide will look like the image given below: 

 

How to Save a Presentation 

There are multiple options to save a presentation. The frequently used options are: 

 Click on the Microsoft Office Button then select Save or Save As from the menu. 

See the image: 

 

 Click on the first icon of the Quick Access Toolbar. 

 

How to Add Slide 

There are multiple ways to add slide in PowerPoint presentation. The frequently used option is to click the New 

Slide button. 

See the image: 

 



The other ways to add a slide are: Office Themes, Duplicate Selected Slide and Reuse Slides. 

1) Using Office Themes to add slide: 

Skip Ad 

 Select the slide next to which you want the new slide to appear 

 In Home tab, click the drop-down arrow on the New Slide button 

 It will display the office themes 

 Select the slide choice that suits your requirement 

See the image: 

 

2) Using Duplicate Selected Slide option to add slide: 

 Select the slide you want to duplicate 

 In Home tab, click the drop-down arrow of New Slide button 

 Left click the Duplicate Selected Slide 

See the image: 

 

3) Using Reuse Slides option to add slide: 

 Select the slide next to which you want the new slide to appear 

 In Home tab, click the drop-down arrow of New Slide button 

 Select the Reuse Slides option 

 Click on Browse then click on Browse File 

 Select the slide from the presentation that you want to import 

See the images: 

  



 

 

How to Apply Themes 

Themes are design templates that make the presentation colorful and stylist. With a single click you can apply a 

theme to the entire presentation. 

 Open the Design tab 

 Locate the Themes group 

 Click the desired theme 

 Theme will be added to the entire presentation 

To see all available Themes click the drop- down arrow on the right bottom corner of the Themes group. 

 

How to Apply or Change Color in Themes 

 Open the Design tab 

 Click the drop-down arrow next to Colors in the Themes group 

 With a left click select the desired color set 

 To create new color set click the Create New Theme Colors 

See the image: 

 



How to Change the Background of a Theme 

 Open the Design tab 

 Locate the Background group 

 Click the Background Styles button 

 Select the desired background style 

See the image: 

 

 

How to Delete Text 

Two simple ways to delete text are: 

1. Place the cursor next to the text then press the backspace key, as the cursor moves left it starts deleting 

text. 

2. Keep the cursor next to text then left click the mouse and without releasing the mouse drag it over the 

text to select it. Then press the Delete key. 

 

How to Format Font Size 

 Select the text you want to modify 

 Open the Home tab and locate the Font group 

 In Font group click the drop-down arrow next to font size option 

 A list of various font sizes appears 

 Move the cursor over the list and select the desired font size 

See the image: 

 

How to Format Font Style 

 Select the text you want to modify 

 Select Home tab and locate the Font group 



 In Font group click the drop-down arrow next to font style option 

 A list of font styles appears 

 Move the cursor over the list and select the desired font style 

See the image: 

 

 

How to Format Text Color 

 Select the text you want to change 

 In Home tab locate the Font group 

 In Font group click the drop-down arrow next to font color icon 

 Font color menu appears 

 Select the desired font color 

See the image: 

 

How to Change Text Alignment 

1. Select the text 

2. In Home tab locate the Paragraph group 

3. There are four alignment options at the bottom of Paragraph group 

4. Select the desired alignment option 

The four alignment options are: 

 Align Text Left: Aligns text towards left margin 

 Center: Brings the text at center 

 Align Text Right: Aligns text towards right margin 

 Justify: Aligns text towards both left and right margin 

 



See the image: 

 

How to Insert a Text Box 

In addition to placeholders you can insert text boxes in the slide. To add a text box follow the below listed 

steps. 

 Open the Insert tab 

 In Text group click the Text Box command 

 Click on the slide and drag the cursor until text box takes the desired width 

 Then release the mouse 

See the image: 

 

You can move and resize the text box. To move the text box click in the box and drag the mouse to the desired 

location. 

How to Copy and Paste Text 

 Select the text you want to copy 

 In Home tab click the Copy command in Clipboard group 

 Place the cursor where you want to paste the text 

 In Clipboard group click the Paste command 



 

How to Cut and Paste Text 

 Select the text you want to cut 

 In Home tab click the Cut command in Clipboard group 

 Place the cursor where you want to paste the text 

 In Clipboard group click the Paste command 

See the image: 

 

 

How to Insert Picture and Clip Art 

To Add Picture: 

1. Click the Insert tab 

2. In Illustrations group click on the Picture button 

3. Insert Picture dialogue box appears 

4. With a click select the desired picture 

5. Click Insert, the picture will be added to the slide 

6. Click and drag the picture to move it to desired location 

See the image: 

 



To Add Picture: 

 Click the Insert tab 

 In Illustrations group click the Clip Art button 

 Clip Art task pane appears on the right side 

 In task pane you will notice three fields: Search for, Search in, Results should be 

See the image: 

Nested Structure in C in Hindi 

Keep Watching 

 

In "Search Field" you can enter the keyword related to clipart you want to insert 

In "Collection Field" click the drop-down arrow. It gives four options. Choose the option that suits your 

requirement. 

See the image: 

 

In "Results should be" filed click the drop-down arrow, you will find five options. Choose the option that suits 

your requirement. 

See the image: 

 



Now click the "Go". Clip Art menu will appear. Select the desired clip art or click the drop- down arrow next to 

clip art, it will display Insert option to add the clip art. 

  

How to Insert Table 

 Place the cursor on the slide where you want to insert the table 

 Click the Insert tab, it will display Tables group on the left 

 Click the Table button, it will display four options to insert the table: 

1) Highlight the Number of Rows and Columns 

You will see small boxes on top, select the boxes corresponding to number of rows and column that you want 

in your table. 

See the image: 

 

2) Insert Table 

21.1Difference between JDK, JRE, and JVM 

Click the Insert Table option and enter the number of rows and columns then click ok. 

See the image: 



 

3) Draw Table: 

Click the Draw Table option and place the cursor on slide. Cursor changes into a pencil. Click and drag the 

pencil to draw a table border. 

See the image: 

 

How to Insert Chart 

 Select the Insert tab 

 In Illustrations group click on Chart command 

 An Insert Chart dialogue box appears 

 Select the desired Chart style and click Ok 

 Chart will be added to slide and an Excel worksheet appears on right side of the slide 

See the images: 

  



 

 

How to Enter Chart Data 

We can't enter data directly in charts. To enter data in chart we have to type it in excel spreadsheet that appears 

when you add Chart or click Edit Chart option. 

The data that you enter in spreadsheet automatically appears in the Chart. Select the cell of spreadsheet and 

type the data it will appear in the slide. Repeat the process to enter the entire data. 

See the image: 

 

How to Format Chart or Chart Data 

When you select the chart three new tabs Design, Layout and Format appear in the Ribbon. Each tab contains 

specific groups of chart tools to format charts and chart data. 

The Design tab contains four groups; Type, Data, Chart Layouts and Chart Styles. 

See the image: 

 

The Layout tab contains six groups; Current Selection, Insert, Labels, Axes, Background and Analysis. 

Skip Ad 



See the image: 

 

The Format tab contains five groups; Current Selection, Shape Styles, WordArt Styles, Arrange and Size. 

See the image: 

 

 

How to Apply Animation Effect 

 Select the text or object you want to animate 

 Select the Animations tab 

 In Animations group click the drop-down arrow next to Animate option 

 Animation options will appear 

 Move the cursor over different options to see live preview on the slide 

 Select the desired animation 

See the image: 

 

 

How to Apply a Custom Animation Effect 

 Select the text or object 

 Select the Animation tab 

 In Animation group click the Custom Animation 

 Custom Animation task pane appears on the right 

 Click the Add Effect, it will display four options that are further divided into different options 

 Select the desired effect 

 

 



See the image: 

 

 

How to Apply Slide Transition Effects 

Transition effects appear when one slide changes into next slide in a Slide Show. 

 Select the slide to which you want to apply the effect 

 Select the Animation tab 

 In Transition to This Slide group you will see the transition effects 

 Click the drop-down arrow to see menu of transition effects 

 Select the desired transition effect 

 Click Apply To All to apply the effect to all slides 

See the image: 

 

 

How to Set Slide Transition Sound 

13. Select the slide to which you want to add the transition sound 

14. Select the Animation tab 

15. In Transition to This Slide group click the drop-down arrow next to Transition Sound option 

16. A list of different transition sounds appears 

17. Select the desired transition sound 

18. Click Apply To All to apply the effect to all slides 

See the image: 

 



How to Set Slide Transition Speed 

 Select the slide 

 Select the Animation tab 

 In Transition to This Slide group click the drop-down arrow next to Transition Speed option 

 It will display three options for transition speed 

 Select the desired transition speed 

 Click Apply To All to apply the same transition speed to all slides 

See the image: 

 

How to Advance Slides 

 Select the slide 

 Select the Animations tab 

 In Transition to This Slide group locate the Advance Slide section 

 It shows two options; On Mouse Click and Automatically After 

 Enter the desired time for the selected slide in Automatically After option 

 Select the next slide and choose the desired time 

 Click Apply To All If you want to apply the same timing to all slides 

See the image: 

 

Viewing Slides 

Once you create the presentation you can view it in different ways. 

Select the View tab. Locate the Presentation Views group. It displays four options to view presentations; 

Normal View, Slide Sorter View, Slide Show View and Notes Page View. 

Normal View: The normal view appears by default when we open the PowerPoint window. We create and edit 

slides in Normal View. This view also offers three view options out of four options in the form of buttons on 

the status bar. 

 

 

 

 



See the image: 

 

Slide Sorter View: It offers miniature or thumbnail version of all slides. You can see all your slides at one time 

in the screen. You can also drag or delete the slides to rearrange them. 

See the image: 

 

Slide Show View: It displays your presentation in full screen mode. It also offers an additional menu at the left 

bottom corner of the slide. 

See the image: 

 

 

Notes Page View 

This view provides space below the slide to add notes. 

See the image: 

 

 

 



 

The pros and cons of Powerpoint 

The pros of Powerpoint 

 Insert Photos from my computer and from the web with ease. 

 Auto arrangement of graphics and texts is made available through suggested formatting. 

 Spell check as I type is very valuable to me. It autocorrects many words. I like for my presentation to be 

accurate. 

 The ability to change any font or any size of font is very valuable to me. 

 The ability to cut and past from Microsoft Word is valuable to me. It also allows me to import tables I 

have already created in Word. 

 It's global and accepted very well by everyone. 

 Infographics design and word arts feature. 

 Visualization of data is very vibrant. 

 Animation feature. 

 Offline access to prepare the ppt. 

 Easy to understand and user-friendly interface. 

The Cons of Powerpoint 

 I would like for PowerPoint to automatically assume that I want my transitions to come from the left 

rather than from the bottom. I don't ever use a transition from the bottom. 

 Learning the control keys has made my work much faster, but where to find the shortcut keys is a 

challenge. Maybe a menu for shortcut keys would be helpful. 

 I like to save to my computer, PowerPoints wants everything to be save in OneDrive. 

 Existing layout designs need to improved or new designs can be incorporated. 

 More design ideas can be incorporated. 

 Infographics can be built in helping the users. 

 

Slideshow 

A slideshow, slide show, or slide presentation is a series of pictures or pages of information (slides), often 

displayed on a large screen using a video projector. ... Transitions can include words fading in or out of 

view, words sliding into view from the left, right, top, or bottom of the slide. The steps are: 

 To start your slide show, on the Slide Show tab, select Play From Beginning. ... 

 To manage your slide show, go to the controls in the bottom-left corner and do any of the following: ... 

 To skip to any slide in the presentation, right-click the screen and select Go to Slide. 

 

Setting up Presenter View to run automatically 

The presenter view is an alternate way to run your presentation in PowerPoint. In this view, your slides are 

projected on screen, and the details of your presentation are displayed on your computer as pictured below. 



The presenter view includes your next (non-hidden) slides that is coming up, your current slide projected on 

screen, how long you‘ve been talking and your speaker notes. 

 

To launch the Presenter View from the beginning of your presentation using your Ribbon, simply: 

 Navigate to the Slide Show tab 

 Hold down the Alt key on your keyboard 

 Click From Beginning 

Holding down the Alt key and clicking From Beginning, the Presenter View will launch from the very first 

(non-hidden) slide in your presentation. 

To learn how to print your speaker notes in PowerPoint (including multiple slides per page),  

You can also launch the presenter view from the beginning of your presentation at anytime by clicking Alt + 

F5 on your keyboard. 

A slide show is a presentation of a series of still images on a projection screen or electronic display device, 

typically in a prearranged sequence. The changes may be automatic and at regular intervals or they may be 

manually controlled by a presenter or the viewer. Slide shows originally consisted of a series of 

individual photographic slides projected onto a screen with a slide projector. When referring to the video or 

computer-based visual equivalent, in which the slides are not individual physical objects, the term is often 

written as one word, slideshow 

A slide show may be a presentation of images purely for their own visual interest or artistic value, sometimes 

unaccompanied by description or text, or it may be used to clarify or reinforce information, ideas, comments, 

solutions or suggestions which are presented verbally. Slide shows are sometimes still conducted by a presenter 

using an apparatus such as a carousel slide projector or an overhead projector, but now the use of an electronic 

video display device and a computer running presentation software is typical  

 

Slideshow Uses  

A well-organized slide show allows a presenter to fit visual images to an oral presentation. The old adage "A 

picture is worth a thousand words" holds true, in that a single image can save a presenter from speaking a 

paragraph of descriptive details. As with any public speaking or lecturing, a certain amount of talent, 

experience, and rehearsal is required to make a successful slide show presentation. 

Presentation software is most commonly used in the business world, where millions of presentations are created 

daily. Another very important area where it is used is for instructional purposes, usually with the intention of 

creating a dynamic, audiovisual presentation. The relevant points to the entire presentation are put on slides, 

and accompany a spoken monologue. 

Slide shows have artistic uses as well, such as being used as a screensaver, or to provide dynamic imagery for 

a museum presentation, for example, or in installation art. David Byrne, among others, has 

created PowerPoint art. 
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Printouts of presentation 

1. Select File > Print. 

2. For Printer, select the printer you want to print to. 

3. For Settings, select the options you want: 

 Print All Slides: To print each slide on a single sheet or change to just print a range of slides.  

 Slides: From the drop-down, choose to print all slides, selected slides, or the current slide. Or, in 

the Slides box, type which slide numbers to print, separated by a comma. 

 Print Layout: Choose to print just the slides, just the speaker notes, an outline, or handouts. The 

number of slides per page is also an option, an effective way to save paper.  

The Outline prints only the text in the slides, without images. The Notes of a presentation show the 

slide and the related speaker notes below it. If you choose to print Handouts, you can print several 

slides on one page using a variety of layouts, some with space for note-taking. 

 Color: Choose whether you want color, grayscale, or pure black and white.  

 Edit Header & Footer: Select to edit the header and footer before printing. 

4. For Copies, select how many copies you want to print. 

5. Select Print. 

 

Printed handouts:  

By default, in PowerPoint for Microsoft 365 (beginning with version 1810), printed handouts include a slide 

number below each slide image. 

You can turn off this option in the Print dialog box on the same menu where you chose to print Handouts. At 

the bottom of the menu are several toggle options with check marks. Clear the check mark next to Print slide 

numbers on handouts: 

 
 

  



UNIT-V: 

 INTERNET AND NETWORKING         (L-11+ T-2 HOURS) 

Introduction to Internet: WWW and Web Browsers: Basic of Computer networks; LAN, WAN; Concept of 

Internet; Applications of Internet; connecting to internet; What is ISP; Knowing the Internet; Basics of internet 

connectivity related troubleshooting, World Wide Web; Web Browsing software, Search Engines; 

Understanding URL; Domain name; IP Address; Using e-governance website 

 

 

Introduction to Internet 

Internet 

Internet is a global communication system that links together thousands of individual networks. It allows 

exchange of information between two or more computers on a network. Thus internet helps in transfer of 

messages through mail, chat, video & audio conference, etc. It has become mandatory for day-to-day activities: 

bills payment, online shopping and surfing, tutoring, working, communicating with peers, etc. 

In this topic, we are going to discuss in detail about concepts like basics of computer networks, Local Area 

Network (LAN), Wide Area Network (WAN), concept of internet, basics of internet architecture, services on 

internet, World Wide Web and websites, communication on internet, internet services, preparing computer for 

internet access, ISPs and examples (Broadband/Dialup/Wi-Fi), internet access techniques, web browsing 

software, popular web browsing software, configuring web browser, search engines, popular search 

engines/search for content, accessing web browser, using favorites folder, downloading web pages and printing 

web pages. 

 

S.No. Internet, WWW, Web Browsers Concepts & Description 

1 Basics of Computer Networks 

Computer network is an interconnection between two or more hosts/computers. Different types of 

networks include LAN, WAN, MAN, etc. 

2 Internet Architecture 

Internet is called the network of networks. It is a global communication system that links together 

thousands of individual networks. Internet architecture is a meta-network, which refers to a 

congregation of thousands of distinct networks interacting with a common protocol 

3 Services on Internet 

Internet acts as a carrier for numerous diverse services, each with its own distinctive features and 

purposes. 

4 Communication on Internet 

communication can happens through the the Internet by using Email, Internet Relay Chat, Video 

Conference etc. 

5 Preparing Computer for Internet Access 

We shall learn how to use functions and charts in Microsoft Excel Using Formulas like Addition, 

Subtraction, Multiplication, Division 

https://www.tutorialspoint.com/computer_concepts/computer_concepts_basics_of_computer_networks.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_internet.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_services_on_internet.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_communication_on_internet.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_preparing_computer_for_internet_access.htm


6 Internet Access Techniques 

A chart is a graphical representation of worksheet data. Charts can make data interesting, attractive 

and easy to read and evaluate. They can also help you to analyze and compare data. 

7 Web Browsing Software 

"World Wide Web" or simple "Web" is the name given to all the resources of internet. The special 

software or application program with which you can access web is called "Web Browser". 

8 Configuring Web Browser 

Search Engine is an application that allows you to search for content on the web. It displays multiple 

web pages based on the content or a word you have typed. 

9 Search Engines 

Search Engine is an application that allows you to search for content on the web. It displays multiple 

web pages based on the content or a word you have typed. 

10 Search for the content 

Search Engine helps to search for content on web using the different stages 

11 Accessing Web Browser 

There are several ways to access a web page like using URLs, hyperlinks, using navigating tools, 

search engine, etc. 

 

Web Browser:  

A software application used to access information on the World Wide Web is called a Web Browser. When a 

user requests some information, the web browser fetches the data from a web server and then displays the 

webpage on the user‘s screen.  

It is also important to know in detail about what a web browser is for candidates preparing for Government 

exams. This is because Computer Knowledge is a common topic for many competitive exams and questions 

based on web browsers may be asked.  

History of Web Browser 

Today web browsers are easily accessible and can be used on devices like computer, laptops, mobile phones, 

etc. but this evolution of making browsers available for easy use took many years.  

Given below are some salient points which one must know with regard to the history of web browsers: 

 ―WorldWideWeb‖ was the first web browser created by Tim Berners Lee in 1990. This is completely 

different from the World Wide Web we use today  

 In 1993, the ―Mosaic‖ web browser was released. It had the feature of adding images and an innovative 

graphical interface. It was the ―the world‘s first popular browser‖ 

 After this, in 1994, Marc Andreessen (leader of Mosaic Team) started working on a new web browser, 

which was released and was named ―Netscape Navigator‖ 

 In 1995, ―Internet Explorer‖ was launched by Microsoft. It soon overtook as the most popular web 

browser. 

 In 2002, ―Mozilla Firefox‖ was introduced which was equally as competent as Internet Explorer 

 Apple too launched a web browser in the year 2003 and named it ―Safari‖. This browser is commonly 

used in Apple devices only and not popular with other devices 

https://www.tutorialspoint.com/computer_concepts/computer_concepts_internet_access_techniques.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_web_browsing_software.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_configuring_web_browser.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_search_engines.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_search_for_content.htm
https://www.tutorialspoint.com/computer_concepts/computer_concepts_accessing_web_browser.htm
https://byjus.com/govt-exams/computer-knowledge/


 Finally, in the year 2008, Google released ―Chrome‖ and within a time span of 3 years it took over all 

the other existing browsers and is one of the most commonly used web browsers across the world 

 

Functions of Web Browser 

Our dependency on the Internet has massively increased. Stated below are functions of web browsers and how 

are they useful: 

 The main function is to retrieve information from the World Wide Web and making it available for 

users 

 Visiting any website can be done using a web browser. When a URL is entered in a browser, the web 

server takes us to that website 

 To run Java applets and flash content, plugins are available on the web browser 

 It makes Internet surfing easy as once we reach a website we can easily check the hyperlinks and get 

more and more useful data online 

 Browsers user internal cache which gets stored and the user can open the same webpage time and again 

without losing extra data  

 Multiple webpages can be opened at the same time on a web browser 

 Options like back, forward, reload, stop reload, home, etc. are available on these web browsers, which 

make using them easy and convenient 

 

Types of Web Browser 

The functions of all web browsers are the same. Thus, more than the different types there are different web 

browsers which have been used over the years. 

Discussed below are different web browser examples and their specific features: 

1. WorldWideWeb 

 The first web browser ever 

 Launched in 1990 

 It was later named ―Nexus‖ to avoid any confusion with the World Wide Web 

 Had the very basic features and less interactive in terms of graphical interface 

 Did not have the feature of bookmark 

2. Mosaic 

 It was launched in 1993 

 The second web browser which was launched 

 Had a better graphical interface. Images, text and graphics could all be integrated 

 It was developed at the National Center for Supercomputing Applications 

 The team which was responsible for creating Mosaic was lead by Marc Andreessen 

 It was named ―the world‘s first popular browser‖ 

3. Netscape Navigator 

 It was released in 1994 



 In the 1990s, it was the dominant browser in terms of usage share 

 More versions of this browser were launched by Netscape 

 It had an advanced licensing scheme and allowed free usage for non-commercial purposes 

4. Internet Explorer 

 It was launched in 1995 by Microsoft 

 By 2003, it has attained almost 95% of usage share and had become the most popular browsers of all 

 Close to 10 versions of Internet Explorer were released by Microsoft and were updated gradually 

 It was included in the Microsoft Windows operating system 

 In 2015, it was replaced with ―Microsoft Edge‖, as it became the default browser on Windows 10 

5. Firefox 

 It was introduced in 2002 and was developed by Mozilla Foundation 

 Firefox overtook the usage share from Internet Explorer and became the dominant browser during 2003-

04 

 Location-aware browsing was made available with Firefox 

 This browser was also made available for mobile phones, tablets, etc. 

6. Google Chrome 

 It was launched in 2008 by Google 

 It is a cross-platform web browser 

 Multiple features from old browsers were amalgamated to form better and newer features 

 To save computers from malware, Google developed the ad-blocking feature to keep the user data safe 

and secure 

 Incognito mode is provided where private searching is available where no cookies or history is saved 

 Till date, it has the best user interface 

 

Basic of Computer networks 

Computer network is an interconnection between two or more hosts/computers. The connectivity can be 

physical by using cables or virtual using wireless network. Different types of networks include LAN, WAN, 

MAN, etc., as shown below − 

 

Local Area Network (LAN) 

Local Area Network (LAN) provides data communication within shorter distance and connects several devices 

such as computers and printers. This type of network contains computers that are relatively closer and are 



physically connected with cables and wireless media. Any network that exists within a single building, or even 

a group of adjacent buildings, is considered as LAN. It is often used to connect separate LANs together so they 

can communicate and exchange data. 

 

Wide Area Network (WAN) 

Wide Area Network is connecting two or more LANs together, generally across a wide geographical area. 

Example 

A company may have its corporate headquarters and manufacturing plant located in one city and marketing 

office in another city. Each site needs resources, data and programs locally, but it also needs to share data with 

other sites. To accomplish this, the company can attach devices that connect over public utilities to create a 

WAN. 

 

Metropolitan Area Network (MAN) 

Metropolitan Area Network (MAN) is an extensive network that connects numerous corporate LANs together. 

Usually MANs are not owned by sole organization. Their communication devices and equipment are 

maintained by a group or single network provider that sells its networking services to corporate customers. 

MANs often take the role of high-speed network that allows sharing of regional resources. MANs also can 

provide a mutual connection to other networks using a WAN link. 

 

 



Internet Applications 

Applications that require the Internet to run or use those applications are called Internet applications. Or you 

can also say that those applications have been made to run from the Internet itself. 

Because all the data of internet applications is on their servers, if you want to use these applications then you 

must have an internet connection. So that through the internet your request goes to the server and in return you 

get information. You can also exchange your information through these applications. 

In any case, you need internet service to use the internet application. Without internet service, you cannot 

access the information of these applications. And one thing, to use internet applications, you also need a digital 

device with an internet connection, only then you can use those applications. Digital devices such as 

smartphones, tablet PCs, laptops, desktops, etc. 

 

Today is the era of Internet applications, today there is a specific application to do every work, using which you 

can do those tasks very easily. Today we will know in detail about the same applications of the Internet. 

 

There are various applications of internet in points, which are given below. 

 Communication 

 Job Search 

 Online Shopping 

 Web Browsing 

 Stock Market Updates 

 Travel 

 Research 

 E-Commerce 

 Online Payments 

 Social Networking 

 E-banking 

 Education 

 Entertainment 

 

1. Communication 

Communication is also one of the most used applications of the Internet because today it is very easy to talk 

through the Internet and today almost everyone is communicating with each other through the Internet. 

 

Today it is very cheap to communicate through the Internet, as compared to other mediums, so people today are 

using Internet applications to communicate. Today, there are thousands of such Internet applications for 

communication, through which you can communicate with someone else. But we will tell you about some 

popular communication applications. Through these communication applications, you can talk to anyone in 

many ways. For example, you can talk to someone through chat, you can talk through voice call, you can talk 

through video call, etc. 

We will tell you about similar applications that run through the Internet. 

There are some popular communication internet applications, which are given below. 

 Email 

 Skype 

 Google Meet 

 Zoom 

 WhatsApp 

 Facebook Messenger 



Email 

The full form of email is electronic mail. If it is understood in simple language, then email means, a message 

sent through electronic means. In earlier times, people used to send messages to someone through a postman, 

which took a lot of time, but in today's time, people use email to send messages to someone. 

 

Through email, you can also send an email to someone in a few seconds and can also receive email from 

anyone. You just need to have an internet connection to send or receive emails. 

 

Through email, you can send text messages, program files, spreadsheets, photos, videos, etc to anyone. Email is 

mostly used by professional people. There are various Uses of Email. 

 

Skype 

Skype is a telecommunications application run by Skype Technologies. Skype is a VoIP-based application. 

VoIP means Voice-over-Internet Protocol. Through Skype you can do video conferencing, voice calls, 

messaging, file transfer, etc. Skype is a very popular videoconferencing application. 

Internet is a network of networks. Millions of computer all over  the world are connected through the internet. 

Computer users  on the internet can contact with one another anywhere in the  world. If a computer is 

connected to the internet, one can  connect to millions of computers. It is very much similar to the  telephone 

connection where one can talk with any person  anywhere in the world.  

On the internet, a huge resource of information is accessible  to people across the world. Information in every 

field starting  from education, Science, Health, Medicine, History and  Geography to business, news, etc. can be 

retrieved from the  internet. One can also download programs and software  packages from the internet.  

Due to the tremendous information resources the internet can  provide, it is now indispensable to every 

organization and  personal activities.  

 

Some of the popular services of the internet are:  

1. E-mail: Sending and receiving mail electronically.  

2. File Transfer: Transferring files from one computer to another. 3. WWW (World Wide Web): 

Retrieving information residing on the internet  servers in the form of websites.  

3. Chat: Exchanging views or communicating information instantly. 

The development of internet started when US Defense  Department set up the ARPANET (Advanced Research 

Project  Agency Network) to have a failure proof communication  network for defense department of US.  

This architecture was later adopted by an educational institute  for an exchange of views among research 

scholars and then, it  was thrown open to the public. Since 1994, the internet has  grown by leaps and bounds 

driven by cheaper cost, easier to  use and increase in information. 

2) On-line communication:  

Computer users around the world use the E-mail services to communicate with each other  extensively.  

https://quicklearncomputer.com/uses-of-email/


3) Feedback about products:  

Commercial organizations are also using the internet to gather information about the satisfaction  of existing 

products and market opportunities of new products. 

This is usually accomplished by  putting up an interactive survey application by the organization on a WWW 

site on the Internet.  

4) Product promotion:  

Several commercial organizations are effectively using the internet services for promoting their  products by the 

use of different social networks.  

5) Customer Support Service:  

Many organizations are also using the internet to provide timely customer support. 

6) On-line shopping:  

The Internet has also facilitated the introduction of a new market concept, which consists of virtual  shops. 

These shops remain open 24 hrs all the year round and are accessible to make purchase all  around the world.  

7) On-line journals and magazines:  

There are many WWW sites on the internet, which consists of an electronic version of many  journals and 

magazines.  

8) Real-time updates: 

It helps to provide news and other happenings that may be on-going in different parts of the word  but with the 

use of the internet, we come to know about the real-time updates in every field be it  in business, sports, 

finance, politics, entertainment and others very easily. 

Many time the decisions  are taken on the real-time updates that are happening in the various parts of the world 

and for this,  the internet is very essential and helpful.  

9) Research:  

In order to do research, we need to go through hundreds of books as well as the references and that  was one of 

the most difficult jobs to do earlier. 

Since, the internet came into life, everything is  available in just a click. The user just has to search for the 

concerned topic and will get hundreds  of references that may be beneficial for the research and since, 

the internet is here to make research  activity easy and hence, public user can take a large amount benefit from 

the research work that  have been done.  

10) Education:  

Education is one of the best things that the internet can provide. There are a number of books,  reference books, 

online help centers, expert`s views and other study oriented material on  the internet that can make the learning 

process very easier as well as a fun to learn.  

11) Financial Transaction:  

It is a term which is used when there is an exchange of money. With the use of internet in the  financial 

transaction, the work has become a lot easier. Payments, Funds transfer, banking  transactions can be done 

through on-line banking service.  



12) Entertainment:  

The Internet is also used for entertainment. Such as chatting with friends, sharing videos, watching  movies, 

listening music, live telecast of sports and other events, playing games, etc. 

13) Job Search:  

Using internet, searching job has become an easier task. There are an endless amount of websites  on 

the internet that provided news about a vacancy in various post as required.  

14) Blogging:  

There are many people who are very much interested in writing blogs and for them the internet is  the best 

place. They can not only write blogs as per their wish but can also publicize their work so  that their work 

reaches to most of the people and they get appreciated.  

 

Positive and Negative Impact of Internet 

The positive impacts of internet to the society, organization and individual are: 

1. Faster, cheaper and easier medium of communication. 

2. Information sharing and browsing. 

3. File transferring facility. 

4. Reach to the worldwide viewers. 

5. Effective, easier, faster and cheaper promotion of product or service. 

6. Better customer support and customer relationship management (CRM). 

7. Online services like banking, shopping, education, etc. 

8. E-mail communication for sending and receiving an electronic document. 

9. Enhanced collaboration between different organizations. 

10. Effective Supply Chain Management (SCM). 

11. Electronic payment system using credit /debit cards, ATM, online payment, electronic cheque, 

smart card, electronic purse, etc. 

12. Newsgroups for instant sharing of news and feedback system. 

13. Creation of new job opportunities related with the internet. 

14. Source for entertainment. 

15. Social networking for instant touch with friends and relatives. 

 

Misuses of Internet / Negative impacts of Internet 

The negative impacts of internet to the society, organization and individual are: 

1. It is the most common medium for spreading malicious software like virus, worm, etc. 

2. It has increased piracy. 

3. Pornography (uploading, publishing, viewing sexual contents in the form of text, image, audio 

and video). 

4. Stealing, modifying or destructing data. 

5. Piracy of software, audio, video or other intellectual contents. 

6. Hacking of organizational system, website, database etc. 

7. It is also used to harass people by sending insulting comments, making vulgar cartoons, 

blackmailing, etc. 

8. Unemployment problem for the individuals not having knowledge about the Internet. 

9. It has increased digital divide. 

 

Connect to the Internet 

Before connecting to the Internet, you must determine the method you want to use. Are you going to be 

connecting to the Internet using a modem or a broadband Internet connection? Or do you want to use your 
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smartphone to provide Internet service to your computer? Below is additional information about these types of 

connections and how to utilize them. 

 

If you are reading this page in a web browser on a digital device, you are connected to the Internet. 

1. Connecting to the Internet with a modem. 

2. Connect to the Internet with broadband. 

3. Connect to the Internet using a smartphone. 

 

1. Connecting to the Internet with a modem 

Connecting to the Internet using dial-up (e.g., a 56k modem) is still viable despite the growing use of 

broadband Internet connections. However, a dial-up connection is much slower. If you plan on doing more than 

the occasional web surfing or reading and sending e-mail, consider broadband. 

Using dial-up to connect to the Internet requires your computer to have an internal or external modem and a 

home phone line (landline). 

Note 1: 

Most new computers don't have a modem. If your computer has a modem, it should have an RJ-11 connection 

(not to be confused with an RJ-45 connection). 

Note 2: 

A dial-up modem should not be confused with a broadband or cable modem. 

How to find the type of computer modem. 

Once you have verified you have a modem; you need to find an ISP (Internet service provider). In most areas, 

you can connect to the Internet using a local ISP. Alternatively, you may want to consider a large ISP, such 

as AOL or MSN, which provide Internet service in many areas all over the world. 

Tip: 

Your ISP should provide instructions on connecting your modem to their Internet service, and troubleshooting 

support for connectivity issues. 

Check your local listings for companies that provide an Internet connection. Also, talk to your friends or family 

to see whom they like to use as an Internet service provider. 

 

2. Connect to the Internet with broadband 

Connecting to the Internet using broadband is much faster than a standard 56k modem. Having more bandwidth 

lets you do more exciting things on the Internet, such as watch movies, listen to music, and play games, and 

better load times for websites. 

Most broadband services are provided by a phone or cable company. Contact your local phone or cable service 

providers to see if broadband is available in your area. 

If broadband service is available in your area, the company can provide the hardware (e.g., cable modem) 

required to access their service. This hardware usually connects to a Network card (RJ-45 connector) on a 
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computer using a Cat 5 network cable. If your provider does not offer a wireless router, you can purchase a 

router to share your Internet connection with multiple computers and devices. 

Note 

Your ISP should provide instructions on connecting your modem to their Internet service, and troubleshooting 

support for connectivity issues. Some broadband ISP companies send a technician to your home and set up 

Internet service to your computer. 

 

3. Connect to the Internet using a smartphone 

You may also use your smartphone to connect to the Internet by tethering, a process that turns it into a wireless 

access point. 

Configuring your phone and computer for Internet service differs depending on your phone's operating system 

and manufacturer. Check online for specific instructions for the tethering software and smartphone you are 

using. 

How to turn your smartphone into a Wi-Fi hotspot. 

However, not all smartphones are capable of tethering, and not all cell phone carriers allow smartphones on 

their network to be used for tethering. 

Tip 

Before tethering your smartphone, we recommend contacting the phone carrier to see if it supported and how 

much they charge. 

 

What is ISP? 

An Internet Service Provider (ISP) is the industry term for the company that is able to provide you with access 

to the Internet, typically from a computer. If you hear someone talking about the Internet and they mention their 

―provider,‖ they‘re usually talking about their ISP. 

Your ISP makes the Internet a possibility. In other words, you can have a shiny computer with a built-in 

modem and could have a router for networking, but without a subscription with an ISP, you won‘t have a 

connection to the Internet. 

For the typical homeowner or apartment dweller, the ISP is usually a ―cable company‖ that, in addition, or 

offering a TV subscription, also offers an Internet subscription. You don‘t get both for the price of one, 

however. You can get just cable TV or just high-speed Internet, or both. 

An ISP is your gateway to the Internet and everything else you can do online. The second your connection is 

activated and set up, you‘ll be able to send emails, go shopping, do research, and more. The ISP is the link or 

conduit between your computer and all the other ―servers‖ on the Internet. You may feel like you‘re talking to 

your mom directly through email, but in reality, it‘s more ―indirectly.‖ Your email goes from your computer to 

the ISP computers/servers, where it‘s sent along to its destination through other servers on the network. 

Of course, that‘s its ―electronic‖ path: the transmission is still virtually instantaneous. 
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Every home or organization with Internet access has an ISP. The good news is, we don‘t all have to have the 

same provider to communicate with each other and we don‘t have to pay anything extra to communicate with 

someone who has a different ISP. 

Whereas just about anyone can have a website, not everyone can be an ISP. It takes money, infrastructure, and 

a lot of very smart technicians. Your ISP maintains miles of cabling, employs hundreds of technicians, and 

maintains network services for its hundreds of thousands of subscribers. Depending on where you live, you 

typically have a choice of ISPs. 

 

Types of ISPs 

In the 1990s, there were three types of ISPs: dial-up services, high-speed Internet (also referred to as 

―broadband‖) offered by cable companies, and DSL (Digital Line Subscribers) offered by phone companies. By 

2013, dial-up services were rare (even though they were cheap), because they were very slow…and the other 

ISP options were typically readily available and much, much faster. 

 

DSL and Cable. 

Two of the leading DSL ISPs have been Verizon and AT&T. But in the last few years (from 2013), DSL has 

been on the decline, while cable-based ISPs, like Comcast and Time Warner, have been growing. Why the 

change? It‘s because the phone companies have been getting more into the lucrative smartphone business, and 

selling annual contracts for cellular service along with…smartphone Internet capabilities. 

That‘s left a lot of the broadband business for the cable companies. 

 

Knowing the Internet 

History and Evolution of the Internet 

The Internet completely revolutionised communication and technology across the Globe. Initially, 

computerised devices were only used for large industries but later its usage increased massively. 

It is also mandatory for people to know that it is not possible for a single person to develop something as broad 

and wide as the Internet all by himself/herself. It was a combined effort of multiple researchers and 

programmers that the Internet was discovered.  

Given below are a few important points which played an extremely important role in the development of the 

Internet and making it one of the most widely used resources across the world.  

 The first development was the introduction of host-to-host network interactions. This was first observed 

in ARPANET in 1969. It was developed by Advanced Research Projects Agency (APRA) of the 

Department of Defence, U.S. It was one of the first general usage of computer networks. 

 Next step was commercialising the usage and making the transistors and transmitters fit in smaller 

devices for convenient Internet usage for the general public. This was introduced in the 1970s 

 Moving forward, satellites and wireless communication was the main target. Defence Advanced 

Research Projects Agency (formerly ARPA), supported satellite-based radio packets for mobile usage of 

networks 

 The next was the development of Transmission Control Protocol (TCP). This enabled different 

machines and networks across the world to assemble data packets. It was in the 1980s that the TCP/IP 

approach was adapted by researchers and technologists, following the footsteps of the U.S. Department 

of Defence 



 With the introduction of personal computers, the demand for commercial Internet usage increased. This 

was the time when Ethernet and other Local Area Networks cam in the foreground 

 In 1993, the web browser was introduced, which followed the point-and-click approach and is now a 

widely used operation for Internet users 

 The late 1990s was the time when thousands of Internet Service Providers has taken up the market and 

most of them were from the U.S. 

 And then the 21st century brought in an amalgamation of technology and wireless Internet accessibility 

for its users. Wherein, wireless broadband services came in as a boon for Internet users 

Amid all these developments which were made, a lot of successes and failures came in but today, the Internet is 

one such commodity which has made lives easier and brought in a wider pace for development across the 

globe. 

Since Computer Awareness is an important topic from the Government examination point of view, candidates 

can get a more understandable explanation of the Internet and its various aspects by reviewing the video given 

below: 

 

Ways To Connect To Internet 

The different ways in which one can connect to the Internet are discussed below in brief: 

 Dial-Up – In such connections, users are required to link their phone line to a computer to access the 

Internet. Under this connection, the user cannot make or receive phone calls through tier home phone 

service 

 Broadband – Provided either through cable or phone companies, Broadband is a high-speed internet 

connection which is widely used today 

 Wireless Connection – Wi-fi and Mobile service providers fall under this category. Internet 

connectivity is made via radio waves and the Internet can be connected anywhere, irrespective of the 

location. Given below are a few examples of wireless connection: 

 Wi-fi – Wireless Fidelity or wi-fi allows high-speed internet connectivity without the use of 

wires 

 Mobile Phones – All smartphones are now equipped with an option for Internet connectivity 

which can be availed using Internet vouchers and packs. No external connection or wire is 

required for these 

 Satellite – Where broadband connections are unavailable, satellites are used for wireless Internet 

connectivity 

 Integrated Services Digital Network – ISDN allows users to sent audio or video data using 

telephone lines 

Internet Connection Protocols 

Protocols are a set of rules that help in governing the way in which any particular body or technology works. 

Internet Connection Protocols can be divided into three major types: 

 TCP/IP Network Model – Transmission Control Protocol (TCP) and Internet Protocol (IP) are the 

most widely used protocols for connecting networks. It divides any message into a series of packets 

which are sent from source to destination 

 File Transfer Protocol – Program files, multimedia files, text files, documents, etc. can be transferred 

from one device to another, using FTP 

 Hypertext Transfer Protocol – Used for transferring a hypertext from one device to two or more 

devices. HTML tags are used for creating links and these links may be in the form of text or images 



Pros and Cons of Using the Internet 

Intentionally or unintentionally, Internet usage is a part in the day to day lives of every individual. The Internet 

has made lives easy and comfortable, but at the same time made human being dependable for the smallest or 

biggest of information. Discussed below are the uses of the internet, along with a few cons that it brings along. 

Pros of Internet 

 Easy Access to Information – Information on anything and everything are available online. The 

Internet makes it convenient to learn about new things at any point in time and get details on various 

subjects, irrespective of time and place 

 Platform for Online Education – With the advanced technology, even students and adults wish to 

learn new things and gaining knowledge at various online portals has become more accessible 

 Job Hunting – Employers can look for employees on the internet and the job seekers can apply online 

for jobs using the Internet 

 Platform to become an Entrepreneur – Today, thousands of people have started their own websites 

and getting good business and users/customers by making their own websites and selling products or 

services. This has become accessible due to Internet connectivity 

 Visual and Graphical Representation of Things – Various researches have shown that a person tends 

to get more engaged with a graphical representation of things. Internet has made this facility also 

convenient for both user and creator  

 Reduced the parameter of Distance – Social media has reduced the distance between people as 

communication has become much easier because of Internet connection   

With the Internet being an extremely essential part of daily life, it is important that a person is well aware of the 

disadvantages of the Internet and its excess usage. 

Cons of Internet 

 Dependency – The dependency of people for looking things and information online has increased 

massively since the introduction of Internet and its easy access 

 Cyber Crime – People do not just use internet for learning purposes, cybercrime has also been at a 

distinctive high because of effortless availability of resources 

 Distraction – People can easily find online games, interesting information, etc. online which may be a 

cause of distraction for may 

 Bullying and Trolls – Online platforms are being used for unethical practises like bullying people and 

trolling them 

  

Basics of internet connectivity related troubleshooting: 

In this tutorial, we are only concerned about the computer networking fault diagnosis and rectification. 

Based on the type of issue, we will discuss its troubleshooting steps and tips. 

Basic Network Problems 

 Cable Problem: The cable which is used to connect two devices can get faulty, shortened or can be 

physically damaged. 

 Connectivity Problem: The port or interface on which the device is connected or configured can be 

physically down or faulty due to which the source host will not be able to communicate with the 

destination host. 

 Configuration Issue: Due to a wrong configuration, looping the IP, routing problem and other 

configuration issues, network fault may arise and the services will get affected. 

 Software Issue: Owing to software compatibility issues and version mismatch, the transmission of IP 

data packets between the source and destination is interrupted. 



 Traffic overload: If the link is over utilized then the capacity or traffic on a device is more than the 

carrying capacity of it and due to overload condition the device will start behaving abnormally. 

 Network IP issue: Due to improper configuration of IP addresses and subnet mask and routing IP to the 

next hop, the source will not be able to reach the destination IP through the network. 

Network Troubleshooting Flowchart 

 
 

 

World Wide Web: 

WWW stands for World Wide Web. A technical definition of the World Wide Web is : all the resources and 

users on the Internet that are using the Hypertext Transfer Protocol (HTTP). 

A broader definition comes from the organization that Web inventor Tim Berners-Lee helped found, 

the World Wide Web Consortium (W3C). 

The World Wide Web is the universe of network-accessible information, an embodiment of human knowledge. 

In simple terms, The World Wide Web is a way of exchanging information between computers on the Internet, 

tying them together into a vast collection of interactive multimedia resources. 

Internet and Web is not the same thing: Web uses internet to pass over the information. 

 

 

Evolution 

World Wide Web was created by Timothy Berners Lee in 1989 at CERN in Geneva. World Wide Web 

came into existence as a proposal by him, to allow researchers to work together effectively and efficiently 

at CERN. Eventually it became World Wide Web. 

The following diagram briefly defines evolution of World Wide Web: 
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WWW Architecture 

WWW architecture is divided into several layers as shown in the following diagram: 

 

 

Identifiers and Character Set 

Uniform Resource Identifier (URI) is used to uniquely identify resources on the web and UNICODE makes 

it possible to built web pages that can be read and write in human languages. 

Syntax 

XML (Extensible Markup Language) helps to define common syntax in semantic web. 

Data Interchange 

Resource Description Framework (RDF) framework helps in defining core representation of data for web. 

RDF represents data about resource in graph form. 

Taxonomies 

RDF Schema (RDFS) allows more standardized description of taxonomies and other ontological constructs. 

Ontologies 

Web Ontology Language (OWL) offers more constructs over RDFS. It comes in following three versions: 

 OWL Lite for taxonomies and simple constraints. 

 OWL DL for full description logic support. 

 OWL for more syntactic freedom of RDF 

Rules 

RIF and SWRL offers rules beyond the constructs that are available from RDFs and OWL. Simple Protocol 

and RDF Query Language (SPARQL) is SQL like language used for querying RDF data and OWL 

Ontologies. 



Proof 

All semantic and rules that are executed at layers below Proof and their result will be used to prove deductions. 

Cryptography 

Cryptography means such as digital signature for verification of the origin of sources is used. 

User Interface and Applications 

On the top of layer User interface and Applications layer is built for user interaction. 

WWW Operation 

WWW works on client- server approach. Following steps explains how the web works: 

1. User enters the URL (say, http://www.tutorialspoint.com) of the web page in the address bar of web 

browser. 

2. Then browser requests the Domain Name Server for the IP address corresponding to 

www.tutorialspoint.com. 

3. After receiving IP address, browser sends the request for web page to the web server using HTTP 

protocol which specifies the way the browser and web server communicates. 

4. Then web server receives request using HTTP protocol and checks its search for the requested web 

page. If found it returns it back to the web browser and close the HTTP connection. 

5. Now the web browser receives the web page, It interprets it and display the contents of web page in web 

browser‘s window. 

 

Future 

There had been a rapid development in field of web. It has its impact in almost every area such as education, 

research, technology, commerce, marketing etc. So the future of web is almost unpredictable. 

Apart from huge development in field of WWW, there are also some technical issues that W3 consortium has to 

cope up with. 

1. User Interface 

Work on higher quality presentation of 3-D information is under deveopment. The W3 Consortium is also 

looking forward to enhance the web to full fill requirements of global communities which would include all 

regional languages and writing systems. 

2. Technology 

Work on privacy and security is under way. This would include hiding information, accounting, access control, 

integrity and risk management. 



3. Architecture 

There has been huge growth in field of web which may lead to overload the internet and degrade its 

performance. Hence more better protocol are required to be developed. 

 

Web Browsing software : 

The most popular web browsing software includes − 

Google Chrome 

Google Chrome is a web browsing software developed in the year 2008 by Google Inc. First, it was designed 

for windows platform, and later adopted to Linux, Macintosh, and even Android. It is written using C++, 

Assembly, Python, and JavaScript. 

Mozilla Firefox 

Mozilla Firefox is a web browsing software developed in the year 2002 by the Mozilla Foundation. It is 

designed to work on all operating systems like Windows, Macintosh, Linux, and Android. It is written using 

C++, JavaScript, Rust, C, CSS, XUL, and XBL. 

Opera 

Opera is a web browsing software developed in the year 1995 by Opera Software. It is designed to work on all 

operating systems like Windows, Macintosh, and Linux and is written using C++ language. 

Internet Explorer 

Internet Explorer is a web browsing software developed in the year 1995 by Microsoft. It is designed to work 

on all operating systems like Windows, Macintosh, Linux and Android and is written using C++ language. 

 

Search Engines 

Introduction 

Search Engine refers to a huge database of internet resources such as web pages, newsgroups, programs, 

images etc. It helps to locate information on World Wide Web. 

User can search for any information by passing query in form of keywords or phrase. It then searches for 

relevant information in its database and return to the user. 

 

Search Engine Components 

Generally there are three basic components of a search engine as listed below: 

1. Web Crawler 

2. Database 

3. Search Interfaces 

4. Web crawler 



It is also known as spider or bots. It is a software component that traverses the web to gather information. 

Database 

All the information on the web is stored in database. It consists of huge web resources. 

Search Interfaces 

This component is an interface between user and the database. It helps the user to search through the database. 

Search Engine Working 

Web crawler, database and the search interface are the major component of a search engine that actually makes 

search engine to work. Search engines make use of Boolean expression AND, OR, NOT to restrict and widen 

the results of a search. Following are the steps that are performed by the search engine: 

 The search engine looks for the keyword in the index for predefined database instead of going directly to 

the web to search for the keyword. 

 It then uses software to search for the information in the database. This software component is known as 

web crawler. 

 Once web crawler finds the pages, the search engine then shows the relevant web pages as a result. 

These retrieved web pages generally include title of page, size of text portion, first several sentences etc. 

These search criteria may vary from one search engine to the other. The retrieved information is ranked 

according to various factors such as frequency of keywords, relevancy of information, links etc. 

 User can click on any of the search results to open it. 

Architecture 

The search engine architecture comprises of the three basic layers listed below: 

 Content collection and refinement. 

 Search core 

 User and application interfaces 

 

 

Search Engine Processing 

Indexing Process 

Indexing process comprises of the following three tasks: 

 Text acquisition 

 Text transformation 

 Index creation 



Text acquisition 

It identifies and stores documents for indexing. 

Text Transformation 

It transforms document into index terms or features. 

Index Creation 

It takes index terms created by text transformations and create data structures to suport fast searching. 

Query Process 

Query process comprises of the following three tasks: 

 User interaction 

 Ranking 

 Evaluation 

User interaction 

It supporst creation and refinement of user query and displays the results. 

Ranking 

It uses query and indexes to create ranked list of documents. 

Evaluation 

It monitors and measures the effectiveness and efficiency. It is done offline. 

 

Examples 

Following are the several search engines available today: 

Search Engine Description 

Google It was originally called BackRub. It is the most popular search engine 

globally. 

Bing It was launched in 2009 by Microsoft. It is the latest web-based search 

engine that also delivers Yahoo‘s results. 

Ask It was launched in 1996 and was originally known as Ask Jeeves. It includes 

support for match, dictionary, and conversation question. 

AltaVista It was launched by Digital Equipment Corporation in 1995. Since 2003, it 

is powered by Yahoo technology. 

AOL.Search It is powered by Google. 

LYCOS It is top 5 internet portal and 13th largest online property according to Media 

Matrix. 

Alexa It is subsidiary of Amazon and used for providing website traffic 

information. 

 

  



Understanding URL: 

URL 

Every document on the Web has a unique address. This address is known as Uniform Resource Locator (URL). 

Several HTML/XHTML tags include a URL attribute value, including hyperlinks, inline images, and forms. All 

of them use the same syntax to specify the location of a web resource, regardless of the type or content of that 

resource. That's why it is known a Uniform Resource Locator. 

URL Elements 

A URL is made of up several parts, each of which offers information to the web browser to help find the page. 

It is easier to learn the parts of a URL, if you look at the example URL given below, there are three key parts: 

the scheme, the host address, and the file path. The following section will discuss each of them: 

http://www.tutorialspoint.com/index.htm 

The Scheme 

The scheme identifies the type of protocol and URL you are linking to and therefore, how the resource should 

be retrieved. For example, most web browsers use Hypertext Transfer Protocol (HTTP) to pass information to 

communicate with the web servers and this is the reason a URL starts with http://. 

There are other schemes available and you can use either of them based on your requirement: 

 

Sr.No Scheme & Description 

1 http:// 
Hypertext Transfer Protocol (HTTP) is used to request pages from Web servers and send them back 

from Web servers to browsers. 

2 https:// 
Secure Hypertext Transfer Protocol (HTTPS) encrypts the data sent between the browser and the 

Web server using a digital certificate. 

3 ftp:// 
File Transfer Protocol is another method for transferring files on the Web. While HTTP is a lot more 

popular for viewing Web sites because of its integration with browsers, FTP is still commonly used 

protocol to transfer large files across the Web and to upload source files to your Web server. 

4 file:// 
Used to indicate that a file is on the local hard disk or a shared directory on a LAN. 

 

The Host Address 

The host address is where a website can be found, either the IP address (four sets of numbers between 0 and 

255, for example 68.178.157.132 ) or more commonly the domain name for a site such as 

www.tutorialspoint.com. Note that "www" is not actually part of the domain name although it is often used in 

the host address. 

 

 

 



The File Path 

The filepath always begins with a forward slash character, and may consist of one or more directory or folder 

names. Each directory name is separated by forward slash characters and the filepath may end with a filename 

at the end. Here index.htm is the filename which is available in html directory: 

https://www.tutorialspoint.com/html/index.htm 

 

Other Parts of the URL 

Using credentials is a way of specifying a username and password for a password-protected part of a site. The 

credentials come before the host address, and they are separated from the host address by an @ sign. Note how 

the username is separated from the password by a colon. The following URL shows the username admin and 

the password admin123: 

https://admin:admin123@tutorialspoint.com/admin/index.htm 

Using the above URL, you can authenticate administrator and if provided ID and Password are correct then 

administrator will have access on index.htm file available in admin directory. 

You can use a telnet URL to connect to a server as follows : 

telnet://user:password@tutorialspoint.com:port/ 

Another important information is Web Server Port Number. By default HTTP Server runs on port number 80. 

But if you are running a server on any other port number then it can be porvided as follows, assuming server is 

running on port 8080: 

https://www.tutorialspoint.com:8080/index.htm 

Fragment identifiers can be used after a filename to indicate a specific part of the page that a browser should go 

immediately. Following is an example to reach to the top of page html_text_links.htm. 

https://www.tutorialspoint.com/html/html_text_links.htm#top 

You can pass some information to the server using URL. When you use a form on a webpage, such as a search 

form or an online order form, the browser can append the information you supply to the URL to pass 

information from your browser to the server as follows − 

https://www.tutorialspoint.com/cgi-bin/search.cgi?searchTerm=HTML 

Here, searchTerm=HTML is passed to the server where search.cgi script is used to parse this passed 

information and take further action. 

Absolute and Relative URLs 

You may address a URL in one of the following two ways: 

 Absolute − An absolute URL is the complete address of a resource. For example 

http://www.tutorialspoint.com/html/html_text_links.htm 

 Relative − A relative URL indicates where the resource is in relation to the current page. Given URL is 

added with the <base> element to form a complete URL. For example /html/html_text_links.htm 

 

 

 



Reserved and Unsafe Characters 

Reserved characters are those have a specific meaning within the URL. For example, the slash character 

separates elements of a pathname within a URL. If you need to include a slash in a URL that is not intended to 

be an element separator then you need to encode it as %2F: 

Unsafe characters are those have no special meaning within the URL but may have a special meaning in the 

context the URL is written. For example, double quotes ("") delimit URL attribute values in tags. If you need to 

include a double quotation mark directly in a URL, you would probably confuse the browser. Instead, you 

should encode the double quotation mark to avoid any possible conflict. You can check HTML URL 

Encoding tutorial to understand this encoding, reserved and unsafe characters. 

 

Domain name 
A domain name is a string of text that maps to an alphanumeric IP address, used to access a website from client 

software. In plain English, a domain name is the text that a user types into a browser window to reach a 

particular website. For instance, the domain name for Google is ‗google.com‘. 

The actual address of a website is a complex numerical IP address (e.g. 192.0.2.2), but thanks to DNS, users are 

able to enter human-friendly domain names and be routed to the websites they are looking for. This process is 

known as a DNS lookup. 
 

Who manages domain names? 

Domain names are all managed by domain registries, which delegate the reservation of domain names 

to registrars. Anyone who wants to create a website can register a domain name with a registrar, and there are 

currently over 300 million registered domain names. 
 

What is the difference between a domain name and a URL? 

A uniform resource locator (URL), sometimes called a web address, contains the domain name of a site as well 

as other information, including the protocol and the path. For example, in the URL 

‗https://cloudflare.com/learning/‘, ‗cloudflare.com‘ is the domain name, while ‗https‘ is the protocol and 

‗/learning/‘ is the path to a specific page on the website. 
 

What are the parts of a domain name? 

Domain names are typically broken up into two or three parts, each separated by a dot. When read right-to-left, 

the identifiers in domain names go from most general to most specific. The section to the right of the last dot in 

a domain name is the top-level domain (TLD). These include the ‗generic‘ TLDs such as ‗.com‘, ‗.net‘, and 

‗.org‘, as well as country-specific TLDs like ‗.uk‘ and ‗.jp‘. 

To the left of the TLD is the second-level domain (2LD) and if there is anything to the left of the 2LD, it is 

called the third-level domain (3LD). Let‘s look at a couple of examples: 

 

For Google‘s US domain name, ‗google.com‘: 

 ‘.com‘ is the TLD (most general) 

 ‘google‘ is the 2LD (most specific) 

But for Google UK‘s domain name, ‗google.co.uk‘: 

 ‘.com‘ is the TLD (most general) 

 ‘.co‘* is the 2LD 

 ‘google‘ is the 3LD (most specific) 

*In this case, the 2LD indicates the type of organization that registered the domain (.co in the UK is for sites 

registered by companies). 

 

How to keep a domain name secure 

Once a domain name has been registered with a registrar, that registrar is in charge of notifying the registrant 

when their domain is about to expire and giving them the chance to renew, ensuring they do not lose their 

domain name. In some cases, registrars will prey on their users‘ expired domain names by buying those 

domains the second they expire and then selling them back to the original registrant at an exorbitant price. It is 

important to choose an honest and trustworthy registrar to avoid these kinds of predatory practices. 

https://www.tutorialspoint.com/html/html_url_encoding.htm
https://www.tutorialspoint.com/html/html_url_encoding.htm
https://www.cloudflare.com/learning/dns/glossary/what-is-my-ip-address/
https://www.cloudflare.com/learning/dns/what-is-dns/
https://www.cloudflare.com/learning/dns/glossary/what-is-a-domain-name-registrar/
https://www.cloudflare.com/learning/ssl/what-is-https/
https://www.cloudflare.com/learning/dns/top-level-domain/
https://www.cloudflare.com/learning/dns/glossary/expired-domains/


IP Address 

A network address always points to host / node / server or it can represent a whole network. Network address is 

always configured on network interface card and is generally mapped by system with the MAC address 

(hardware address or layer-2 address) of the machine for Layer-2 communication. 

There are different kinds of network addresses in existence: 

 IP 

 IPX 

 AppleTalk 

We are discussing IP here as it is the only one we use in practice these days. 

 

IP addressing provides mechanism to differentiate between hosts and network. Because IP addresses are 

assigned in hierarchical manner, a host always resides under a specific network.The host which needs to 

communicate outside its subnet, needs to know destination network address, where the packet/data is to be sent. 

Hosts in different subnet need a mechanism to locate each other. This task can be done by DNS. DNS is a 

server which provides Layer-3 address of remote host mapped with its domain name or FQDN. When a host 

acquires the Layer-3 Address (IP Address) of the remote host, it forwards all its packet to its gateway. A 

gateway is a router equipped with all the information which leads to route packets to the destination host. 

Routers take help of routing tables, which has the following information: 

 Method to reach the network 

Routers upon receiving a forwarding request, forwards packet to its next hop (adjacent router) towards the 

destination. 

The next router on the path follows the same thing and eventually the data packet reaches its destination. 

Network address can be of one of the following: 

 Unicast (destined to one host) 

 Multicast (destined to group) 

 Broadcast (destined to all) 

 Anycast (destined to nearest one) 

A router never forwards broadcast traffic by default. Multicast traffic uses special treatment as it is most a video 

stream or audio with highest priority. Anycast is just similar to unicast, except that the packets are delivered to 

the nearest destination when multiple destinations are available. 

 

Using e-governance website 



Digital India. National Portal of India: It is developed to provide access to information and services being 

provided by the government. PM India Website: provides information relating to the Prime Minister's Office. 

United Nations e-governance website. 

 

Sl 

No 
Domain 

1 uidai.gov.in 

2 incometaxindiaefiling.gov.in 

3 indiapost.gov.in 

4 ap.gov.in 

5 passportindia.gov.in 

6 rajasthan.gov.in 

7 epfindia.gov.in 

8 kerala.gov.in 

9 gujarat.gov.in 

10 ssc.nic.in 

11 incometaxindia.gov.in 

12 upsc.gov.in 

13 india.gov.in 

14 mahadiscom.in 

15 nvsp.in 

16 indane.co.in 

17 bsesdelhi.com 

18 mponline.gov.in 

19 delhimetrorail.com 

20 mygov.in 

21 kseb.in 

22 sscnr.net.in 

23 makeinindia.com 



 


